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1 Despre acest document

1.1 Funcţia documentului
Acest manual ar trebui să ofere asistenţă în timpul configurării sistemului Tankvision 
Professional NXA85.
Acesta se referă la funcţiile de bază pe care operatorii trebuie să le îndeplinească în timpul 
funcţionării zilnice. 
În afară de cunoştinţele de bază de operare PC, nu este necesară nicio pregătire specială 
pentru a efectua operaţiunile sistemului Tankvision Professional. Cu toate acestea, se 
recomandă un curs de formare asupra sistemului, ţinut de către Endress+Hauser.

1.2 Versiuni de software şi certificare
Din cauza procesului de certificare cu agenţiile de metrologie, cea mai recentă versiune 
de software ar putea fi certificată doar într-o etapă ulterioară. De asemenea, unele 
caracteristici ar putea fi incompatibile cu reglementările în materie de metrologie şi, 
prin urmare, nu pot fi combinate.

1.3 Simboluri

1.3.1 Simboluri de siguranţă

1.3.2 Simboluri electrice 

Simbol Semnificaţie

A0011189-EN

PERICOL!
Acest simbol vă avertizează cu privire la o situaţie periculoasă. Neevitarea acestei 
situaţii va avea drept rezultat vătămări corporale grave sau decesul.

A0011190-EN

AVERTISMENT!
Acest simbol vă avertizează cu privire la o situaţie periculoasă. Neevitarea acestei 
situaţii poate avea drept rezultat vătămări corporale grave sau decesul.

A0011191-EN

ATENŢIE!
Acest simbol vă avertizează cu privire la o situaţie periculoasă. Neevitarea acestei 
situaţii poate avea drept rezultat vătămări corporale minore sau medii.

A0011192-EN

NOTIFICARE!
Acest simbol conţine informaţii despre proceduri şi alte aspecte care nu duc la 
vătămări corporale.

Simbol Semnificaţie

A0011197

Curent continuu
O bornă la care se aplică tensiune de curent continuu sau prin care circulă curent continuu.

A0011198

Curent alternativ
O bornă la care se aplică tensiune de curent alternativ sau prin care circulă curent alternativ.

A0011200

Conexiune de împământare
O bornă de împământare care, în ceea ce priveşte operatorul, este împământată printr-un 
sistem de împământare.

A0011199

Conexiunea de împământare de protecţie
O bornă care trebuie conectată la împământare înainte de a efectua orice altă conexiune.

PERICOL

AVERTISMENT

ATENȚIE

NOTIFICARE

)

*



Despre acest document Tankvision Professional NXA85 - System Operation

6 Endress+Hauser

1.3.3 Simboluri pentru anumite tipuri de informaţii

1.3.4 Simboluri din grafice

1.4 Documentaţie
Următoarele tipuri de documentaţii sunt disponibile în secţiunea Downloads a site-ului web 
Endress+Hauser: www.endress.com/downloads

Pentru o prezentare generală a domeniului documentaţiei tehnice asociate, consultaţi 
următoarele: 

•W@M Device Viewer: www.endress.com/deviceviewer - Introduceţi numărul de serie 
de pe plăcuţa de identificare

•Aplicaţia Endress+Hauser Operations: Introduceţi numărul de serie de pe plăcuţa de 
identificare sau scanaţi codul matricei de pe plăcuţa de identificare

1.5 Mărci comerciale înregistrate
Microsoft®, Windows® şi Internet Explorer® 

Mărci comerciale înregistrate ale Microsoft Corporation

Modbus™
Modbus este o marcă comercială înregistrată a Schneider Electric USA, Inc.

Java®

Marcă comercială înregistrată a Sun Microsystems, Inc.

Mozilla® Firefox®

Marcă comercială înregistrată a Mozilla Foundation

Enraf, Honeywell, Rosemount, Rosemount, Emerson, Saab, L&J, VAREC, GPE sunt mărci 
comerciale înregistrate şi mărci comerciale ale acestor organizaţii şi companii.
Toate celelalte mărci sunt proprietatea titularilor lor respectivi.

Simbol Semnificaţie

A0011193

Recomandare
Indică informaţii suplimentare.

A0011195

Trimitere la pagină
Se referă la numărul paginii corespunzătoare.

 ,  ,  ... Serie de etape

A0018373

Rezultat al unei succesiuni de acţiuni

Simbol Semnificaţie

1, 2, 3 ... Numere elemente

 ,  ,  ... Serie de etape

A, B, C ... Vizualizări

A0011187

Zonă periculoasă
Indică o zonă periculoasă.

A0011188

Indică o unitate nepericuloasă
Zonă sigură (zonă care nu prezintă pericol)

1. 2. 3.

1. 2. 3.

-

.



Tankvision Professional NXA85 - System Operation Instrucţiuni de siguranţă de bază

Endress+Hauser 7

2 Instrucţiuni de siguranţă de bază

2.1 Cerinţe pentru personal
Membrii de personal responsabili de instalare, punere în funcţiune, diagnosticări şi 
întreţinere trebuie să îndeplinească următoarele cerinţe: 

• Specialişti calificaţi şi instruiţi: trebuie să deţină o calificare corespunzătoare pentru 
această funcţie şi activitate specifică

• Să fie autorizaţi de către proprietarul sau operatorul unităţii
• Să fie familiarizat cu reglementările federale sau naţionale
• Înainte de a începe activitatea, să citească şi să încerce să înţeleagă instrucţiunile din 

manual şi din documentaţia suplimentară, precum şi certificatele (în funcţie de aplicaţie)
• Să urmeze instrucţiunile şi să respecte condiţiile de bază

Personalul de operare trebuie să îndeplinească următoarele cerinţe:

• Este instruit şi autorizat în conformitate cu cerinţele sarcinii de către proprietarul/
operatorul unităţii

• Să urmeze indicaţiile din prezentele instrucţiuni de operare

2.2 Utilizarea prevăzută

2.2.1 Domeniu de utilizare

Tankvision Professional NXA85

Tankvision Professional este special conceput pentru operatorii de depozite de materiale în 
vrac, terminale de comercializare, rafinării şi conducte. Acesta este conceput pentru a 
gestiona toate achiziţiile de date, controlul de supraveghere şi monitorizarea necesare, într-
o singură soluţie complet integrată.

Tankvision Professional integrează toate tipurile majore de instrumente de măsurare pentru 
rezervoare într-un singur sistem.

Toţi parametrii măsuraţi şi calculaţi ai rezervoarelor sunt accesibili operatorilor din parcurile 
de rezervoare şi terminale, precum şi sistemelor gazdă conectate.
Operarea de către mai mulţi utilizatori este asigurată de serverul web încorporat, care oferă 
posibilitatea de a accesa datele din orice locaţie conectată (local sau de la distanţă), de 
exemplu, în scopuri administrative şi contabile.

2.3 Siguranţa produsului
Aparatul de măsură este proiectat în conformitate cu buna practică tehnologică pentru a 
respecta cele mai recente cerinţe de siguranţă; acesta a fost testat, iar la ieşirea din fabrică, 
starea acestuia asigura funcţionarea în condiţii de siguranţă. Acesta îndeplineşte 
standardele de siguranţă şi cerinţele legale generale.

2.4 Securitatea IT
O garanţie din partea noastră poate fi oferită numai dacă aplicaţia software este instalată şi 
utilizată conform specificaţiilor din manualul de utilizare. Aplicaţia software conţine 
mecanisme de siguranţă care o protejează împotriva modificărilor neintenţionate ale 
setărilor software-ului.
Operatorul trebuie să implementeze măsuri de securitate IT care sunt în conformitate cu 
standardele de siguranţă şi securitate ale operatorului şi care sunt concepute pentru a 
proteja suplimentar aplicaţia software şi transferul de date.
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3 Identificare

3.1 Identificarea produsului
Pentru identificarea software-ului sunt disponibile următoarele opţiuni:

• Specificaţiile de pe plăcuţa de identificare
• Codul de comandă cu evidenţierea caracteristicilor software-ului pe nota de livrare
• Introduceţi numerele de serie de pe plăcuţele de identificare în W@M Device Viewer: 

www.endress.com/deviceviewer - Se afişează toate informaţiile despre software.

3.2 Plăcuţă de identificare

A0043752

1 Adresa producătorului
2 Denumire produs 
3 Cod de comandă 
4  Cod de comandă extins (Cod. com. ext.) 
5 Numărul de serie (Nr. ser.) 
6 Certificat şi date relevante pentru omologare
7 Cod de bare
8 Marcajul CE

3.3 Cod de comandă şi versiune dispozitiv
Pentru a afla versiunea software-ului de care dispuneţi, introduceţi codul de comandă 
indicat pe plăcuţa de identificare pe ecranul de căutare la următoarea adresă: 
www.products.endress.com/order-ident

250002972--

Order code:

Ext. Order code:

Ser.-No.:

Tankvision

1 2 3 4 5

6

7

8
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4 Pagina de pornire
Atunci când sistemul Tankvision Professional este lansat din meniul Start sau de la comanda 
rapidă de pe desktop, se încarcă pagina de pornire.
Fiecare rezervor configurat în sistem are o fereastră grafică proprie.
Pagina de pornire are o bară de meniu, o bară de instrumente, un spaţiu de lucru al aplicaţiei 
şi o bară de stare în partea de jos a ferestrei. 
Sistemul porneşte cu pagina de pornire extinsă la maximum şi cu toate ferestrele 
rezervorului deschise, aşa cum se arată în figură.

BA00396G_0199

Funcţiile cel mai frecvent utilizate sunt accesate cu ajutorul barei de instrumente, iar restul 
sunt accesate prin intermediul meniurilor
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4.1 Ferestre multiple

BA00396G_0200

Elementele de meniu care controlează funcţia de ferestre multiple se găsesc în meniurile de 
pe pagina de pornire: Window → New Window, Close Window şi Annotate Window.
• New Window – Deschide o fereastră nouă.
• Close Window – Închide fereastra curentă (nu este disponibilă pe fereastra „master”).
• Annotate Window – Modifică legenda ferestrei curente.

Fiecare instanţă a ferestrei paginii de pornire poate fi adnotată cu un nume de identificare 
pentru a permite utilizatorului să le identifice pe bara de activităţi Windows. Pot fi 
configurate diferite instanţe ale paginii de pornire pentru a afişa diferite seturi de 
rezervoare. Acest lucru permite, de exemplu, ca produsele generale şi produsele GPL să fie 
afişate în ferestre separate. În cazul în care sunt disponibile mai multe monitoare, paginile 
de pornire pot fi dispuse pe monitoare diferite pentru o mai mare claritate.

Închiderea aplicaţiei va închide toate ferestrele. Redeschiderea aplicaţiei va face ca toate 
ferestrele să revină la poziţia lor iniţială.
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4.2 Vedere rezervor
Aceasta este vizualizarea implicită pentru rezervoarele individuale atunci când sunt afişate 
în pagina de pornire. Pentru un exemplu în acest sens, consultaţi următoarea imagine.

BA00396G_0102

Fiecare fereastră sau imitaţie de rezervor este fixă în ceea ce priveşte aspectul general şi 
dimensiunea. Acestea sunt scalabile. Atunci când sunt deschise mai multe reproduceri de 
rezervoare, acestea vor fi aranjate în formă de faianţă în zona disponibilă a ferestrei Home 
page. Atunci când sunt deschise mai multe ferestre decât spaţiul disponibil, vor apărea 
automat bare de defilare în partea dreaptă a ferestrei principale.
Reproducerea rezervorului a fost prevăzută cu o serie de linkuri de scurtătură către alte 
funcţii de afişare şi cu un meniu contextual pentru acces rapid la alte funcţii.

4.3 Fereastra vizualizării de bază a rezervorului
Fereastra afişează:
• Numărul rezervorului
• O reprezentare grafică a rezervorului indicând tipul de rezervor, de exemplu, acoperiş 

conic, acoperiş plutitor etc.
• Produsul alocat rezervorului
• Un grafic cu bare care arată nivelul din rezervor
• O selecţie de câmpuri de date numerice şi textuale care pot fi configurate de utilizator. 
• Dacă o alarmă este activă în prezent pentru rezervor 
• Dacă datele numerice sunt în mod manual sau automat, după caz 
• Starea operaţiunii efectuate asupra rezervorului, adică statică, umplere, golire
• Starea de conectare a aparatului de măsură, şi anume Conectat, Deconectat, În curs de 

conectare, În curs de deconectare 

Dacă starea de conectare este alta decât Conectat, atunci TOATE datele pentru rezervor 
sunt de la ultima conectare a acestuia şi, prin urmare, NU SUNT INSTANTANEE.
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4.3.1 Afişarea datelor în modul manual
Orice valoare a datelor în modul manual este indicată ca atare prin afişarea unui text de 
culoare albastră.
Următoarea fereastră indică faptul că temperatura produsului se află în modul manual.
Prin urmare, datele sunt actualizate prin utilizarea funcţiei de introducere manuală a 
datelor. Vă rugăm să consultaţi secţiunea privind Introducerea manuală a datelor pentru mai 
multe detalii (→ ä 16).

BA00396G_0103

4.3.2 Acces prin comandă rapidă pentru introducerea manuală a 
datelor

Atunci când o valoare numerică se află în modul manual, după cum se observă în figură, 
utilizatorul poate obţine acces rapid la afişajul de introducere manuală a datelor făcând 
dublu clic pe elementul de date manuale. Acest lucru va lansa modulul de introducere 
manuală a datelor.

4.3.3 Comandă rapidă Stări şi moduri TAD
Atunci când este afişată una dintre valorile TAD: Tank Mode, Tank Status şi Product Status, 
un dublu clic pe câmp va afişa o fereastră de dialog Windows pentru a permite modificarea 
valorii rezervorului. Pentru mai multe detalii despre TAD, → ä 80.

4.3.4 Comandă rapidă către Prezentarea generală a unui singur 
rezervor

Dacă daţi dublu clic pe fereastra rezervorului, se lansează afişajul Prezentarea generală a 
unui singur rezervor pentru rezervorul respectiv.
Consultaţi secţiunea privind modulul Prezentarea generală a unui singur rezervor pentru o 
descriere completă (→ ä 19). Accesul la Prezentarea generală a unui singur rezervor este 
disponibil şi din bara de instrumente.
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4.3.5 Rezervor în stare de alarmă
Atunci când un rezervor are orice alarmă activă, pe rezervor apare o pictogramă de alarmă 
cu un claxon, după cum se observă în imagine.

BA00396G_0104

În plus, sub claxon este amplasată o etichetă prescurtată care indică tipul de alarmă. Dacă 
există mai multe alarme active, este afişată alarma cu cea mai mare prioritate. În cazul 
ilustrat, LAHH este alarma Level High High (Nivel extrem de ridicat).

Consultaţi tabelul de mai jos pentru detalii.

Cod de alarmă Descriere alarmă

LAHH Nivel alarmă extrem de ridicat (software)

LAH Nivel alarmă ridicat (software)

LAL Nivel alarmă scăzut (software)

LALL Nivel alarmă extrem de scăzut (software)

HH Nivel alarmă extrem de ridicat (manometru)

H Nivel alarmă ridicat (manometru)

L Nivel alarmă scăzut (manometru)

LL Nivel alarmă extrem de scăzut (manometru)

NO REPLY Niciun răspuns de la manometru

BAD ALARM Colecţie incongruentă de alarme active (de exemplu, nivel de alarmă ridicat şi scăzut 
în acelaşi timp)

GT H Temperatură ridicată (manometru)

GT L Temperatură scăzută (manometru)

PT H Temperatură ridicată (software)

PT L Temperatură scăzută (software)

GD H Densitate ridicată (manometru)

GD L Densitate scăzută (manometru)

PD H Densitate ridicată (software)

PD L Densitate scăzută (software)

PD DA Abatere densitate (software)

PT DA Abatere temperatură (software)

PW H Nivel de apă ridicat (software)

PW L Nivel de apă scăzut (software)

PL VA Alarmă variabilă

PF HF Flux ridicat

PF LF Flux scăzut
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4.3.6 Identificarea alarmei după ce s-a produs
Atunci când o alarmă apare pentru prima dată, se generează un eveniment, apare un 
avertizor pe rezervor şi în vizualizatorul de evenimente de alarmă se emite un avertisment 
sonor sau, opţional, poate fi redat un mesaj vocal.
După ce alarma a fost confirmată, indicaţia rămasă este un avertizor de alarmă pe 
simulatorul rezervorului şi o linie în Vizualizatorul de evenimente de alarmă, ambele 
persistând, în general, până la trecerea stării de alarmă. În plus, rezumatul alarmei active va 
afişa, de asemenea, toate alarmele active.
Pentru a obţine informaţii suplimentare despre alarmele active, faceţi dublu clic pe 
pictograma claxonului.
Se va încărca modulul Alarm Summary. Consultaţi ilustraţia de mai jos.

BA00396G_0201

Modulul Alarm Summary va afişa fiecare dintre alarmele care sunt active. O alarmă activă 
va avea caseta de selectare corespunzătoare bifată.

4.3.7 Identificarea rezervoarelor în mişcare

BA00396G_0202

UMA Mişcare neautorizată după volum

UMAL Mişcare neautorizată după nivel

PL FR Alarmă plafon

PL DA Alarmă de diferenţă software

PU 1...8 Alarmă programabilă definită de utilizator 1...8

Cod de alarmă Descriere alarmă
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Fereastra Tank View identifică rezervoarele în mişcare în mai multe moduri:
• Prin afişarea unui indicator al direcţiei de umplere, de exemplu, o săgeată îndreptată în sus 

sau în jos în funcţie de direcţia de mişcare (aşa cum se arată în figura de mai sus).
• Prin magnitudinea şi semnul debitului, de exemplu, un debit pozitiv reprezintă umplerea, 

iar un debit negativ reprezintă golirea.
• În cele din urmă, în funcţie de configuraţie, culoarea produsului din rezervor poate fi 

utilizată pentru a reprezenta operaţiunea. De exemplu, albastru reprezintă umplerea, 
maro reprezintă golirea, iar verdele reprezintă starea statică. Consultaţi manualul de 
configurare a sistemului BA00390G (capitolul „Setări de sistem”, caseta de selectare Use 
product color pentru a afla modul în care puteţi să activaţi această funcţie.

4.3.8 Stare conexiune
Starea de conectare a rezervorului este afişată în partea dreaptă.

Aceasta va fi una dintre cele patru stări:
• Conectat
• Deconectare
• Deconectat
• În curs de conectare

Starea Connected înseamnă că dispozitivele externe, de exemplu, manometrele 
rezervorului, sunt interogate în mod continuu pentru date. În cazul conexiunilor prin 
modem, este posibil ca datele să fie solicitate doar periodic.
Dacă starea conexiunii este alta decât Connected, atunci TOATE datele rezervorului datează 
de la ultima conectare şi, prin urmare, NU SUNT INSTANTANEE.

BA00396G_0008

În captura de ecran de mai sus, rezervorul se află în starea Disconnected şi va afişa codul de 
diagnosticare DN00 care indică lipsa unui răspuns de la manometru.

4.4 Opţiunile meniului contextual
Este disponibil un meniu contextual. Faceţi clic dreapta în orice fereastră de vizualizare a 
rezervorului şi va apărea meniul contextual, aşa cum este ilustrat mai jos.

BA00396G_0106
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Unele dintre opţiunile din meniul contextual sunt sensibile la configuraţia rezervorului. 
Acestea vor fi discutate în restul acestui capitol.

4.4.1 Produs
Elementul de meniu Product are un alt submeniu care conţine produsele ordonate în 
ordinea utilizării (primul fiind cel care este alocat celor mai multe rezervoare). Această 
opţiune este utilizată pentru a modifica produsul alocat rezervorului. Produsul alocat în mod 
curent este evidenţiat printr-un semn de bifă adiacent şi este colorat în gri. În cazul în care 
există mai mult de douăsprezece produse alocate în prezent rezervoarelor, există o ultimă 
intrare în meniu care afişează un ecran de selecţie a produselor:

BA00396G_0107

Un produs poate fi selectat făcând clic pe săgeată, ceea ce va afişa o listă cu toate produsele 
(din nou, sortate în ordinea utilizării). Alternativ, se poate introduce numele produsului 
dorit. Pe măsură ce se introduce numele produsului, se afişează o listă redusă de produse 
care corespund textului introdus:

BA00396G_0108

4.4.2 Date privind modul manual
Elementul de meniu Manual mode are un alt submeniu care conţine toate opţiunile 
disponibile pentru modul manual. Această opţiune este utilizată pentru a comuta valorile 
între modul manual şi cel automat.
Orice valoare în modul manual va fi evidenţiată de un semn de bifare adiacent.

4.4.3 Activare alarmă
Dacă este vizibilă, această opţiune de meniu duce la un submeniu care va arăta dacă alarma 
este activată sau dezactivată. Un semn de bifare va apărea adiacent opţiunii de meniu, 
arătând că este activată alarma pentru elementul de date respectiv.

4.4.4 Operaţiuni
Dacă este vizibilă şi activată, această opţiune de meniu oferă o modalitate convenabilă de 
accesare a operaţiunilor cu produsul pentru rezervor. Selectarea unei operaţiuni enumerate 
în submeniu va afişa detaliile operaţiunii respective.
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4.4.5 Comenzile dispozitivului
Elementul de meniu Device commands are un alt submeniu care conţine toate comenzile 
dispozitivului disponibile în acest context.

BA00396G_0109

Detaliile comenzilor sunt prezentate în tabelul de mai jos.

Comandă Acţiune

Servo Check Efectuează o verificare a repetabilităţii pe un instrument de măsurare servoacţionat. 
Această comandă va încerca să ridice camera de ardere cu cel puţin 300 mm şi apoi să 
îl readucă la nivelul produsului. Nivelul dinaintea ridicării senzorului este comparat cu 
nivelul după revenirea senzorului la suprafaţa produsului. Dacă ambele se încadrează 
în toleranţa definită, se consideră că funcţia de verificare a servoacţionării a fost 
efectuată. Dacă este creată, aceasta va genera un eveniment. 
Această comandă este disponibilă numai pentru instrumentele de măsurare 
servoacţionate.

Stow Dispune senzorul instrumentului de măsurare în poziţia de blocare sau de oprire 
superioară. Această comandă este disponibilă numai pentru instrumentele de 
măsurare servoacţionate.

Unstow Anulează comanda de dispunere şi readuce senzorul la nivelul produsului. De 
asemenea, poate fi utilizată pentru a anula orice comandă aflată în curs.

Freeze Determină camera de ardere să rămână în poziţia sa curentă.

Unfreeze Eliberează ultima comandă de oprire şi permite camerei de ardere să revină la nivelul 
produsului.

Water Scan Selectarea acestei opţiuni va face ca manometrul să încerce să găsească interfaţa apei 
şi să revină la nivelul produsului. Reţineţi că această comandă va funcţiona numai 
dacă manometrul acceptă scanarea apei.

Density Scan Selectarea acestei opţiuni va determina manometrul să efectueze o scanare a 
profilului de densitate şi va indica densitatea medie măsurată. Reţineţi că această 
comandă va funcţiona numai dacă manometrul dumneavoastră acceptă efectuarea 
profilului de densitate.

Alarm Test Selectarea acestei opţiuni va ridica poziţia elementului dezlocuitor până în partea 
superioară a rezervorului, ceea ce va declanşa orice alarme activate. 
NOTE: în funcţie de tipul de manometru, comenzile pot genera o alarmă. De 
asemenea, în timpul executării comenzilor pot apărea modificări de stare.
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4.5 Utilizarea tastelor funcţionale
Tastele funcţionale pot fi personalizate pentru a acţiona drept comenzi rapide „prin apăsarea 
unei singure taste” către alte funcţii şi caracteristici instalate pe computer. O tastă 
funcţională trebuie mai întâi să fie setată la un executabil, în acest exemplu de vizualizare tip 
grilă.

Localizaţi fişierul FunctionKey.ini în dosarul aplicaţiei
C:\Program Files\Endress+Hauser\Tankvision Professional\.
Apoi editaţi fişierul.

text= Adăugaţi textul pentru elementul de meniu, care în acest caz va fi F2 GridView.
exe= Numele căii de acces pentru fişierul executabil. Nu uitaţi de extensia .exe la sfârşit.
Icon= Numele căii pentru pictogramă. Nu uitaţi de extensia .ico la sfârşit.
hide= Utilizaţi 0 pentru ca elementul să apară în meniul Taste funcţionale.

Exemplu: pentru tasta F2, porneşte vizualizarea tip grilă.
[F2]
text = GridView
exe = GridView.exe
icon = myicons\myicon.ico
hide =0
Opriţi şi reporniţi pagina de pornire pentru a iniţializa funcţionalitatea.

Scan Mode Off Scan, Normal Scan şi Fast Scan sunt opţiuni care se exclud reciproc şi care 
controlează frecvenţa cu care este scanat manometrul.

• Off Scan
Manometrul nu este interogat.

• Normal Scan
Manometrul este interogat la intervale normale.

• Fast Scan
Manometrul este interogat o dată la două interogări (adică mai frecvent), în 
detrimentul celorlalte dispozitive de măsurare.

• Manual Scan
Se utilizează atunci când manometrul este în modul de scanare oprită, pentru a 
face ca acesta să fie interogat o dată

Stare conexiune Connect, Disconnect, Connect Once sunt opţiuni care se exclud reciproc şi care 
determină starea de conectare a portului de interfaţă la care este conectat rezervorul. 
Prin urmare, dacă una dintre aceste comenzi este trimisă unui rezervor, atunci se va 
aplica la TOATE rezervoarele conectate la acelaşi port COM sau modem de pe PC.

• Connect
Interfaţa se va conecta la portul COM sau la modem şi va continua să interogheze 
manometrele pentru date la nesfârşit sau până când utilizatorul trimite o comandă 
de deconectare.

• Disconnect
Interfaţa se va deconecta de la portul COM sau de la modem şi va rămâne 
deconectată. Se vor afişa datele de la ultima reîmprospătare.

• Connect Once
Interfaţa se va conecta la portul COM sau la modem şi se va deconecta automat 
după ce a preluat toate datele de la manometre. Se vor afişa datele preluate din 
conexiune.

În cazul în care se selectează comanda Disconnect, se va afişa o fereastră de 
confirmare, deoarece această comandă va împiedica actualizarea TUTUROR 
dispozitivelor de măsurare de pe aceeaşi interfaţă.
Trebuie menţionat că trimiterea unei comenzi către un rezervor va afecta toate 
celelalte rezervoare de pe aceeaşi interfaţă şi, prin urmare, aceste comenzi trebuie 
utilizate cu prudenţă, deoarece ar putea duce la pierderea datelor pentru rezervoarele 
critice.

Comandă Acţiune
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5 Afişarea datelor pentru un singur rezervor
Single Tank Overview oferă o afişare detaliată a tuturor datelor pentru un singur rezervor.

Aceasta poate fi lansată: 
• Făcând dublu clic pe o fereastră de vizualizare a rezervorului
• Făcând clic pe butonul din bara de instrumente Single Tank Overview 

Odată ce modulul Single Tank Overview a fost încărcat, pot fi vizualizate şi alte rezervoare, 
selectându-le din lista derulantă furnizată.
Datele afişate sunt organizate în grupe logice: date de măsurare primară, debite, date de 
inventar şi setări de alarmă.
Orice valoare a datelor în modul manual va fi afişată în text de culoare albastră.
Orice valoare a datelor indisponibilă din orice motiv va fi înlocuită de un număr de 
diagnosticare.
Consultaţi ilustraţia de mai jos pentru un exemplu în acest sens. 

BA00396G_0204

Sugestiile de instrumente sunt utilizate pe tot parcursul pentru a oferi informaţii 
suplimentare utilizatorului cu privire la fiecare dintre câmpurile de afişare a datelor.
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5.1 Rezervor în stare de alarmă
Dacă rezervorul selectat are o alarmă activă, pe rezervor va fi afişată o pictogramă de claxon. 
Detaliile referitoare la alarmele active pot fi determinate făcând dublu clic pe claxon pentru 
a lansa afişajul Alarm Summary.
Rezumatul alarmei va afişa o bifă pentru fiecare alarmă care este activă la momentul 
respectiv.
Consultaţi ilustraţia de mai jos.

BA00396G_0205

5.2 Vizualizarea temperaturilor elementelor
Unele manometre de pe rezervor au capacitatea de a măsura mai multe puncte de 
temperatură de la dispozitive speciale de măsurare a temperaturii. Acestea sunt denumite în 
mod obişnuit termometre de medie, sonde de temperatură cu puncte multiple etc. 

Profilurile de temperatură pot fi vizualizate numai dacă 

a. Sistemul a fost configurat să interogheze temperaturile elementelor. Pentru a face acest 
lucru, asiguraţi-vă că opţiunea Average Temp. Fitted este bifată pentru manometru în 
ecranul Device Configuration.

b. Subsistemul Trending este configurat să genereze tendinţe ale elementelor de 
temperatură pentru manometrul respectiv. Acest lucru se realizează în ecranul 
Trending Configuration.

Consultaţi manualul de configurare pentru detalii privind elementele de mai sus.

Pentru a afişa ecranul Temperature Profile, faceţi clic pe butonul din ecranul de prezentare 
generală.
Faceţi clic dreapta pentru a adăuga un rezervor la afişaj, conform indicaţiilor de mai jos.
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BA00396G_0013

Datele pot fi afişate în format grafic cu ajutorul filei Graph. În această vizualizare sunt afişate 
şi detalii suplimentare ale profilului, cum ar fi valoarea medie etc.

Afişajul grafic poate fi configurat cu ajutorul următoarelor opţiuni de meniu:
• View → Average Temperature

Bifaţi această opţiune pentru a afişa temperatura medie.
• View → Data Points

Bifaţi acest element pentru a afişa punctele de date individuale pe grafic.
• View → Data Labels

Bifaţi acest element pentru a afişa valorile individuale ale datelor pe grafic.
• Tools → Options

Se afişează o fereastră de dialog în care pot fi configurate culorile utilizate pentru diferitele 
linii de pe grafic.

• Tools → Configure Element Levels
Aceasta afişează o fereastră de dialog în care se pot introduce înălţimile elementelor de 
temperatură. Acestea vor fi apoi utilizate la trasarea graficului, în locul numerelor 
elementelor.

În mod implicit, temperatura de pe grafic va fi scalată folosind valorile minime şi maxime din 
tabel. Cu toate acestea, în acest mod afişajul poate indica uneori valori înşelătoare. Intervalul 
poate fi setat manual prin bifarea elementului Enable Temperature Min/Max şi apoi prin 
introducerea intervalului minim şi maxim.

Graficul poate fi salvat într-o structură bitmap selectând File → Save Graph ...

De asemenea, datele pot fi vizualizate în format tabelar, făcând clic pe fila Data.
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BA00396G_0014

5.3 Vizualizarea datelor de profil
Unele manometre ale rezervoarelor au capacitatea de a realiza un profil de densitate/
temperatură (sau doar de densitate pentru unele manometre) pentru tot produsul.
Aceste date pot fi apoi returnate sub forma unui tabel de densităţi şi temperaturi (dacă este 
suportat) şi stocate în baza de date.
Datele profilului pot fi apoi vizualizate într-un format grafic sau tabelar.

• Vizualizarea unui singur profil
Se poate afişa câte un singur profil pe rând.

Ecranele se deschid din ecranul Single Tank Overview.
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6 Conectarea la sistem

6.1 Securitate
Accesul la caracteristicile sistemului poate fi controlat printr-un cont de utilizator. Obligaţia 
de a se conecta la sistem poate fi dezactivată, permiţând oricărui utilizator accesul deplin la 
sistem. Dacă este activată funcţia de securitate, se aplică următoarele secţiuni.

6.2 Conectarea
Selectaţi Security → Log In... din bara de meniu principală, fie din pagina de pornire (a 
se vedea mai jos), fie din Alarm Event Viewer. Alte modalităţi de a vă conecta sunt 
utilizarea pictogramei Security Manager din bara de sistem Windows sau în mod 
automat atunci când încercaţi să accesaţi o funcţie privilegiată a sistemului.

BA00396G_0015

Va apărea o fereastră de dialog de conectare.

BA00396G_0206

Introduceţi numele de utilizator şi parola necesare.
Detaliile vor fi verificate cu informaţiile din baza de date. Dacă numele de utilizator şi 
parola sunt valide, utilizatorul va fi conectat la nivelul de acces desemnat.

Fiecare cont de utilizator are un nivel desemnat de acces la fiecare funcţie. Prin urmare, 
chiar dacă un utilizator este conectat, nu înseamnă neapărat că are acces la toate 
funcţiile. Nivelul de acces al unui utilizator este determinat de drepturile care îi sunt 
atribuite de către administratorul de sistem.

Atunci când un utilizator este conectat la sistem, numele de utilizator este afişat în 
panoul cel mai din stânga al barei de stare de pe pagina de pornire şi din vizualizatorul 
de evenimente de alarmă, după cum se observă în imaginea de mai jos.

BA00396G_0017

1.

2.

3.

4.
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6.3 Deconectare
Selectaţi opţiunea Security → Log Out din bara de meniu principală.
Sistemul va deconecta imediat utilizatorul conectat la momentul respectiv.
Acest lucru va împiedica accesul la toate funcţiile care necesită conectarea la sistem.

6.4 Configurarea noilor conturi de utilizator
Pentru informaţii suplimentare, consultaţi secţiunea Security Configuration din manualul 
administratorilor de sistem.

Trebuie să se acorde atenţie drepturilor de acces ale noilor utilizatori. Nu toţi utilizatorii 
ar trebui să beneficieze de cel mai înalt nivel de acces. Administratorului de sistem îi 
revine responsabilitatea de a stabili drepturile şi cei cărora le revin aceste drepturi.
Se recomandă ca majoritatea utilizatorilor ocazionali să primească drepturi minime 
pentru început, care să fie ajustate ulterior, pe măsură ce utilizatorii se familiarizează 
mai bine cu funcţionarea sistemului.
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7 Alarme şi evenimente

7.1 Introducere
În multe unităţi, cuvintele alarme şi evenimente sunt adesea confundate. Este necesară o 
explicaţie a acestor termeni în contextul acestui sistem de măsurare şi control al nivelului din 
rezervor.
Pe scurt; Alarmele dau naştere la evenimente.
Să luăm exemplul unei alarme de nivel ridicat; se poate defini o valoare de referinţă la care 
alarma va deveni activă (aceasta implică, de asemenea, că există un punct la care alarma 
devine inactivă). Atunci când alarma devine activă, se înregistrează un eveniment care 
avertizează operatorii în acest sens. Nu toate evenimentele înregistrate de sistem apar ca 
urmare a unor alarme, de exemplu, o defecţiune de comunicare cu instrumentele de teren 
este un eveniment semnificativ, dar nu se bazează pe nicio alarmă.

7.2 Ce se întâmplă atunci când o alarmă devine activă
• O pictogramă cu un claxon de alarmă va fi afişată pe rezervor în cadrul ferestrei de 

vizualizare a rezervorului, după cum se observă în imaginea de mai jos.

BA00396G_0112

• Descrierea stării de alarmă din Grid View şi Single Tank Overview se va schimba pentru a 
reflecta alarma cu cea mai mare prioritate. Pentru codurile prescurtate → ä 13.

• Un eveniment va fi generat de sistem şi va fi afişat în ecranul Alarm Event Viewer.

BA00396G_0208
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• Va fi generat un semnal sonor, dacă este activat. Acesta poate fi sub forma unei sonerii 
interne, a unei plăci de sunet sau a unui claxon extern, în funcţie de opţiunile montate. Prin 
intermediul plăcii de sunet a PC-ului poate fi redat un mesaj vocal dacă a fost activată 
această funcţie.

• Alarmele sunt dezactivate atunci când sunt confirmate. Dacă este activată securitatea, un 
utilizator trebuie să fie conectat la sistem cu privilegiile corecte pentru a confirma alarma.

• Toate alarmele şi evenimentele sunt înregistrate în baza de date. Pentru a examina toate 
alarmele şi evenimentele care au avut loc, se poate utiliza o vizualizare a istoricului 
alarmelor.

• Atunci când se confirmă o alarmă, data şi ora sunt înregistrate în baza de date. De 
asemenea, este înregistrat şi utilizatorul conectat la sistem care confirmă alarma.

7.3 Confirmarea alarmelor
Alarm Event Viewer afişează detaliile alarmelor, după cum se observă în imaginea de mai 
jos:

BA00396G_0113

Starea alarmei este indicată în coloanele din stânga şi din dreapta:

• Roşu
Neconfirmată şi neoprită. În cazul alarmei „Active”, aceasta se va aprinde intermitent.

• Albastru deschis
Oprită, dar neconfirmată.

• Verde
Confirmată.

Pentru a opri sau a confirma o alarmă, este necesar mai întâi să o selectaţi făcând clic cu 
mouse-ul pe rândul respectiv. Odată ce alarma este selectată (indicată de culoarea fundalului 
care devine albastră), aceasta poate fi oprită sau confirmată. Dacă este activată securitatea, 
este necesar să fiţi conectat pentru a opri sau a confirma o alarmă.

Alarma selectată poate fi confirmată prin apăsarea butonului Acknowledge Alarm ( ) 
sau prin utilizarea comenzii rapide de la tastatură (consultaţi opţiunile vizualizatorului de 
evenimente de alarmă).

În cazul în care alarma selectată a fost configurată pentru a necesita un motiv de confirmare, 
se va afişa un ecran cu motivul confirmării:
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BA00396G_0021

Butonul OK este disponibil numai după ce a fost introdus un motiv. Alarma poate fi 
confirmată numai dacă se face clic pe butonul OK.

7.3.1 Oprirea unei alarme
Alarma selectată poate fi oprită făcând clic pe butonul Silence Alarm ( ) sau prin 
utilizarea comenzii rapide de la tastatură (consultaţi opţiunile vizualizatorului de 
evenimente de alarmă).

7.3.2 Confirmarea sau oprirea mai multor alarme
De asemenea, este posibil să confirmaţi sau să opriţi fie o singură alarmă, fie mai multe 
alarme, făcând clic dreapta pe lista de alarme. Astfel, se va afişa un meniu de opţiuni:

BA00396G_0022

Operatorii sunt împiedicaţi să confirme alarme multiple atunci când una sau mai multe 
dintre aceste alarme necesită un motiv de confirmare.
Alarmele care necesită un motiv ar trebui să fie confirmate individual mai întâi.
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7.4 Vizualizatorul istoricului evenimentelor
Event History Viewer poate fi lansat fie făcând clic pe butonul corespunzător din bara de 
instrumente de pe pagina de pornire, fie selectând View → Events din meniul Alarm Event 
Viewer.

BA00396G_0024

În mod implicit, sunt afişate toate evenimentele din ziua curentă. Evenimentele afişate pot 
fi filtrate în funcţie de data de sesizare, dispozitivul de sesizare, data confirmării şi 
utilizatorul confirmat. De asemenea, pentru clienţii conectaţi la mai multe servere este 
posibil să se specifice serverul de pe care trebuie preluate evenimentele. Aceste setări sunt 
memorate atunci când se închide Event History Viewer şi sunt utilizate ca valori implicite la 
următoarea lansare a Event History Viewer.

Vizualizatorul de evenimente afişează, de asemenea, detalii despre acţiunile care pot fi 
auditate. Cu ajutorul butoanelor  şi  este posibil să se filtreze dacă sunt afişate 
evenimente şi/sau acţiuni auditate. Prin dublu clic pe acestea, pot fi afişate detalii 
suplimentare pentru acţiunile auditate. Astfel, se va afişa un ecran care detaliază 
modificările:

BA00396G_0025
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8 Rapoarte
Este furnizat un set standard de rapoarte de inventariere şi de măsurare şi control al 
nivelului din rezervor.

Pentru a accesa rapoartele, procedaţi după cum urmează:

Alegeţi File → Reports din meniul principal al paginii de pornire.

BA00396G_0026

Selectaţi raportul (primul pas din expert):

• Selectarea grupului
Un raport pentru un grup de rezervoare definit de utilizator.

• Selectarea produsului
Un raport care prezintă un rezumat al tuturor rezervoarelor care conţin un anumit produs 
(de exemplu, Jet A1).

• Raport standard de inventar
Afişează o selecţie standard de date de inventar pentru toate rezervoarele.

• Raport standard de sinteză
Rezumă inventarul de produse pentru toate rezervoarele, în funcţie de produs.

• Configurarea manometrului
Un raport care prezintă principalele date de configurare a manometrului.

• Configurarea rezervorului
Un raport care prezintă principalele date de configurare a rezervorului.

• Imprimare personalizată
Permite selectarea unui raport produs de o terţă parte, care să fie executat de sistemul de 
măsurare şi control al nivelului din rezervor. Puteţi selecta un fişier RPT de la intrarea 
Custom din arborele de rapoarte.

La următoarea etapă a expertului, dacă utilizatorul a selectat un raport care necesită 
parametri suplimentari, cum ar fi un produs sau un grup static, utilizatorului i se va oferi 
posibilitatea de a alege parametrul relevant. În cazul în care raportul selectat nu necesită 
alţi parametri, această etapă este omisă.

În cele din urmă, selectaţi „print or preview” (imprimare sau previzualizare) pentru a 
genera o copie pe hârtie a raportului sau o previzualizare pe ecran a raportului. Dacă 
utilizatorul selectează imprimarea, raportul va fi trimis la imprimanta implicită 
configurată în Windows; dacă selectează previzualizare şi apoi imprimare, utilizatorul va 
putea alege imprimanta utilizată.

1.

2.

3.

4.
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9 Vizualizarea tip grilă
Vizualizarea tip grilă este o vizualizare tabelară a datelor rezervorului.
Aplicarea vizualizării tip grilă poate fi personalizată şi include un meniu contextual pentru 
trimiterea comenzilor obişnuite ale dispozitivului.
Utilizatorul îşi poate crea propriile vizualizări de date şi le poate combina cu funcţiile 
standard de grupare a rezervoarelor pentru a personaliza complet prezentarea datelor.
Vizualizarea tip grilă se lansează prin apăsarea butonului corespunzător din bara de 
instrumente.

9.1 Lansarea vizualizării tip grilă
Faceţi clic pe butonul din bara de instrumente GridView sau, alternativ, rulaţi aplicaţia 
GridView.exe din folderul ţintă.
Ilustraţia de mai jos este tipică.

BA00396G_0115

În meniul Grid View File există două elemente pentru New Window şi Close Window.
New Window deschide o fereastră nouă, iar Close Window închide fereastra curentă (nu 
este disponibilă pe fereastra „master”). Noua instanţă poate fi configurată pentru a afişa un 
set de rezervoare diferit de primul. Dacă sunt disponibile mai multe monitoare, ferestrele pot 
fi dispuse pe monitoare diferite pentru o mai mare claritate.

9.2 Selectarea vizualizărilor de date
Vizualizarea tip grilă vine în mod standard cu mai multe vizualizări de date predefinite.
Vizualizările de date disponibile sunt enumerate în lista derulantă din bara de instrumente.
Pentru informaţii, consultaţi ilustraţia de mai jos.

BA00396G_0116
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Vizualizările fixe sunt:
• Tank Gauging 
• Tank Inventory 
• Gauge Status 
• Operaţiuni

Fiecare vizualizare conţine diferite coloane de informaţii, iar alte vizualizări incluse în listă 
vor fi vizualizări definite de utilizator.
Utilizatorul poate configura vizualizări suplimentare.

9.3 Selectarea grupurilor de rezervoare
În mod implicit, modulul GridView afişează toate rezervoarele.
Utilizatorul poate alege unul dintre grupurile de rezervoare preconfigurate pentru a afişa 
numai acele rezervoare care apar în grupul respectiv.
Grupurile disponibile sunt enumerate în lista derulantă din bara de instrumente.
Un exemplu în acest sens este prezentat în ilustraţia de mai jos.

BA00396G_0117

Dacă nu au fost configurate grupuri, lista va fi goală, în afară de grupul fix All Tanks.

9.4 Găsirea unui anumit rezervor
GridView va permite utilizatorului să localizeze un rezervor în cadrul listei de rezervoare. 
Dacă identitatea rezervorului este cunoscută, aceasta poate fi tastată direct în căsuţa 
prevăzută; rândurile din grilă vor fi derulate până când se găseşte rezervorul ales. Alternativ, 
rezervorul poate fi selectat din lista derulantă şi, în mod similar, grila va fi derulată pentru a 
afişa rezervorul selectat.

9.5 Rezervoare în stare de alarmă
Există o serie de butoane pe bara de instrumente pentru a rezuma rapid rezervoarele care au 
o alarmă activă la manometru.

BA00396G_0030

9.6 Configurarea unei noi vizualizări de date
Puteţi genera propria vizualizare personalizată a datelor parcului de rezervoare pentru a se 
potrivi operaţiunilor dumneavoastră. Vizualizarea personalizată va apărea în lista de 
vizualizări alături de cele predefinite (→ ä 30).

Pentru a defini o nouă vizualizare, selectaţi Options → Maintain Views... din meniul 
Grid View.

Ecranul de menţinere a vizualizărilor va fi afişat după cum se observă în imaginea de mai 
jos.

1.

2.
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BA00396G_0031

Faceţi clic pe New şi se va deschide o fereastră care vă va permite să definiţi numele 
vizualizării şi să selectaţi coloanele de date pe care doriţi să le afişaţi. Consultaţi figura 
de mai jos. 
Reţineţi că aceleaşi opţiuni vă vor permite să editaţi vizualizările după ce le-aţi definit.

BA00396G_0032

Pentru o vizualizare nouă, numele vizualizării va fi necompletat, dar trebuie introdus 
înainte ca vizualizarea să poată fi salvată.

Lista din stânga este lista câmpurilor care sunt disponibile pentru a fi adăugate la 
vizualizare. 

Această listă poate fi sortată
• după tip ( )
• alfabetic ( )
• nesortate ( )

Pentru a adăuga un câmp în vizualizare, fie îl selectaţi şi faceţi clic pe butonul de 
adăugare ( ), fie faceţi dublu clic pe el.
Pentru a adăuga toate câmpurile dintr-un anumit tip în vizualizare, selectaţi orice câmp 
din tipul respectiv şi faceţi clic pe butonul ( ).

3.

4.

5.

6.
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Lista din dreapta este lista câmpurilor care se află în prezent în vizualizare. 
Pentru a elimina un câmp din vizualizare, fie îl selectaţi şi faceţi clic pe butonul de 
eliminare ( ), fie faceţi dublu clic pe el. 
Pentru a elimina toate câmpurile din vizualizare, faceţi clic pe butonul de eliminare 
totală ( ).

Pentru a salva modificările şi a ieşi, faceţi clic pe butonul OK. 
Pentru a ieşi fără a salva modificările aduse vizualizării, faceţi clic pe butonul Cancel.

Pentru a şterge o vizualizare, evidenţiaţi-o şi faceţi clic pe butonul Delete. Vizualizarea 
selectată va fi ştearsă.

Pentru a ieşi din menţinere vizualizări, faceţi clic pe butonul Close.

9.7 Culoarea debitului
Atunci când în vizualizare este prezentă o coloană a debitului, rândul care afişează un 
rezervor în mişcare este colorat în maro sau albastru. Rândurile maro indică faptul că nivelul 
din rezervor merge în jos, rândurile albastre indică faptul că nivelul merge în sus, iar 
rezervoarele statice sunt afişate în culoarea de fundal.

BA00396G_0209

Grila menţine trei valori de prag configurabile de către utilizator pentru a determina 
momentul în care trebuie să fie colorat un rând. Valorile de prag sunt utilizate în funcţie de 
faptul că debitul afişat de vizualizare, fie acesta de nivel, de masă sau de volum.
Pentru a configura valorile de prag, alegeţi Options → Set Flow Rate Colour Thresholds... 
din meniu. Se va afişa caseta de dialog Flow rate threshold.

BA00396G_0035

7.

8.

9.

10.
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9.8 Operaţiuni contextuale
În mod similar cu pagina de pornire, este posibil să se emită comenzi de măsurare şi alte 
operaţiuni din grilă. În majoritatea cazurilor, dacă se face clic dreapta pe un anumit rezervor 
din grilă, se va afişa un meniu contextual din care se pot alege aceste operaţii.

9.8.1 Comenzile manometrului
Dacă se face clic dreapta pe un anumit rezervor, se va afişa un meniu contextual de comenzi 
ale manometrului. Reţineţi că, în cazul unui rezervor echipat cu mai multe dispozitive de 
măsurare, comanda va fi trimisă la manometrul cu sarcină principală.

9.8.2 Operaţiuni simple
Există opţiuni pentru a seta şi opri operaţiunile de pe acest ecran. Setarea unei operaţiuni 
implică calcularea nivelului ţintă pentru operaţiune şi configurarea valorilor de referinţă ale 
alarmelor pentru a gestiona operaţiunea, oprirea operaţiunii dezactivează alarmele odată ce 
operaţiunea este finalizată. Pentru mai multe detalii, consultaţi manualul Operaţiuni simple 
BA01653G.

Acest lucru NU se aplică operaţiunilor complete

9.8.3 Afişarea datelor pentru un singur rezervor
Dacă se face dublu clic pe majoritatea coloanelor, se va deschide fereastra de prezentare 
generală a unui singur rezervor (→ ä 19) axată pe rezervorul respectiv de pe rândul 
selectat.

9.8.4 TAD
Dacă se face dublu clic pe o coloană care afişează date TAD, operatorul va putea modifica 
această setare. Pentru mai multe informaţii despre TAD, → ä 80.

9.9 Imprimare şi previzualizarea imprimării
Conţinutul curent al Grid View poate fi trimis la o imprimantă sau poate fi previzualizat pe 
ecran.

9.9.1 Imprimarea unei vizualizări tip grilă
Pentru a imprima conţinutul curent al vizualizării tip grilă, selectaţi File → Print din meniu 
sau apăsaţi butonul de imprimare din bara de instrumente. 
În cazul în care se utilizează elementul de meniu, este posibil să se modifice imprimanta şi 
setările imprimantei care urmează să fie utilizate pentru a imprima Grid View. 
Dacă se utilizează butonul din bara de instrumente, conţinutul curent al Grid View va fi 
tipărit pe imprimanta implicită.
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9.9.2 Previzualizarea unei vizualizări tip grilă
Pentru a previzualiza o imprimare, fie selectaţi File → Print Preview din meniu, fie apăsaţi 
butonul de previzualizare a imprimării din bara de instrumente. Un exemplu de fereastră de 
previzualizare a imprimării este prezentat mai jos.

BA00396G_0036

9.10 Selectare mod
În modul de selectare (prezentat în figura de mai jos), operatorul poate alege ce rezervoare 
să vizualizeze, precum şi datele pentru rezervoarele respective. Acest lucru înseamnă că 
vizualizarea tip grilă poate fi utilizată acum pentru a oferi o vizualizare „la cerere” a datelor 
de măsurare şi control al nivelului din rezervor. Mai simplu spus, operatorul poate trage 
rezervoarele care îl interesează pe panoul de vizualizare dintr-o listă de rezervoare 
disponibile şi le poate ordona în modul cel mai logic la momentul respectiv. Odată ce 
operaţiunile de pe rezervor s-au încheiat, acesta poate fi eliminat pentru a elibera spaţiu pe 
ecran.

BA00396G_0086

Rezervoarele sunt grupate pe familii de produse în panoul din stânga. Rezervoarele şi 
rândurile de separatoare pot fi trase din acest panou pe grila din dreapta. Rândurile pot fi 
inserate în orice punct al grilei.
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9.10.1 Setări
Pentru a schimba modul unui ecran de vizualizare tip grilă, selectaţi File → Settings din 
meniu. Va fi afişată fereastra de dialog Grid View Settings.
Opţiunea Use Select Mode controlează modul de vizualizare tip grilă.

BA00396G_0087

9.10.2 Descriere
Câmpul de descriere permite utilizatorului să numească instanţa particulară a ferestrei de 
vizualizare tip grilă.
Această caracteristică este utilă pentru funcţionarea pe mai multe ecrane, în cazul în care pot 
exista mai multe grile pe ecran în acelaşi timp, fiecare îndeplinind un anumit rol.

9.10.3 Utilizarea modului de selectare
Caseta de selectare Select Mode controlează modul în care va fi afişat ecranul; atunci când 
este bifată, operatorul poate alege ce rezervoare să fie afişate, trăgându-le pe grilă. În partea 
stângă a ecranului este afişată o listă care nu este prezentă în modul standard.

9.10.4 Afişarea unui rezervor o singură dată
Atunci când este bifat, operatorul nu va putea adăuga acelaşi rezervor în grilă de mai multe 
ori. Acest lucru are loc prin eliminarea rezervorului din lista de selecţie din stânga atunci 
când acesta este adăugat în grilă.

9.10.5 Afişarea grupului cu toate rezervoarele
Atunci când este bifat, utilizatorului i se prezintă un grup All Tanks în lista de selectare din 
stânga ecranului.

9.10.6 Grupare după
Lista de selectare din stânga ecranului grupează de obicei rezervoarele pentru a facilita 
localizarea rezervorului care urmează să fie adăugat la grilă. Lista poate fi grupată în funcţie 
de produs sau de un grup static; alternativ, lista poate să nu fie grupată deloc.

9.10.7 Sortare după
Lista de selectare din partea stângă poate sorta rezervoarele fie după nume în ordine 
alfabetică, fie după ordinea rezervoarelor, aşa cum este definită în ecranul Grup de 
rezervoare.
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Opţiunile de filtrare după starea alarmei, de selectare a grupurilor şi de căutare a unui 
anumit rezervor sunt toate eliminate atunci când sistemul se află în modul de selecţie. 
Utilizatorul poate adăuga rezervoare în grilă fie prin tragerea antetului unui grup pe 
grilă (caz în care sunt adăugate toate rezervoarele din grupul respectiv), fie prin 
extinderea unui grup şi tragerea unui singur rezervor pe grilă. Fiecare grup conţine, de 
asemenea, un element „Separator” pentru a permite utilizatorului să definească 
grupuri de rezervoare în grila propriu-zisă. Ordinea rezervoarelor din grilă poate fi 
modificată prin simpla tragere a unui rezervor într-o nouă locaţie.

9.10.8 Funcţionarea pe mai multe ecrane
Pot fi afişate mai multe vizualizări tip grilă în acelaşi timp. Dintre aceste grile, unele pot fi în 
modul de Selectare, altele pot fi în modul Standard. Funcţionarea grilelor în Modul de 
selectare este independentă una de cealaltă, astfel încât puteţi avea o grilă în modul de 
selectare pentru rezervoarele de destinaţie şi o alta pentru monitorizarea operaţiunilor de 
încărcare a rezervoarelor de zi de la faţa locului. Fiecare grilă poate afişa, de asemenea, un 
set diferit de coloane de date, din nou configurate pentru a afişa date relevante pentru 
operaţiunile în curs. Folosiţi File → New Window.

9.10.9 Adăugarea rezervoarelor la grilă în modul de selectare
Pentru a adăuga un rezervor la grilă:

Localizaţi rezervorul în lista de selecţie din stânga.

Faceţi clic şi trageţi rezervorul pe grilă în poziţia dorită.

BA00396G_0168

9.10.10 Eliminarea rezervoarelor din grilă în modul de selectare
Pentru a şterge un rezervor din grilă:

Faceţi clic pe rândul care urmează să fie eliminat şi trageţi-l în afara grilei.

BA00396G_0169

1.

2.

1.
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9.10.11 Reordonarea rezervoarelor din grilă în modul de selectare
Pentru a schimba poziţia unui rezervor în grilă:

Faceţi clic pe rândul care urmează să fie mutat şi trageţi-l în poziţia dorită.

BA00396G_0170

9.10.12 Culori
Culorile celulelor pentru încărcare şi recepţie pot fi acum configurate prin intermediul 
ecranului Customise Colours. Pentru a face acest lucru, mergeţi la meniurile Grid Views: 
Options → Customise Colours.

BA00396G_0171

Astfel, este posibilă modificarea culorilor utilizate pentru a indica rezervoarele şi câmpurile 
în anumite stări:
• Alarmă
• Eroare
• Nereuşit
• Manual
• Scan Mode
• Offline
• Sarcină
• Primire

1.
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10 Comenzi avansate ale dispozitivului
Comenzile pot fi specifice manometrului şi, prin urmare, depind de tipul de manometru.
De exemplu, pentru manometrele Enraf sunt acceptate următoarele funcţii:

• Măsurare prin imersiune
Oferă diferitele moduri de măsurare a interfeţei, cum ar fi funcţiile Find Water Interface, 
Find Product Interface şi Density Dipping.

• Dezlocuire
Asigură funcţii de control al camerei de ardere a manometrului.

• Alarma de testare a manometrului
Oferă posibilitatea de a testa automat valorile de referinţă ale alarmei manometrului radar 
873.

• Întreţinere
Permite utilizatorului să seteze nivelul de referinţă al manometrului.

• Elementele manometrului
Este un instrument general care permite utilizatorului să citească sau să scrie oricare 
dintre elementele de măsurare şi să vizualizeze datele şi/sau răspunsurile returnate.

Alte manometre pot suporta comenzi şi funcţii de configurare diferite.

10.1 Lansarea comenzilor avansate ale dispozitivului
Din meniul de pe pagina de pornire, selectaţi Tools → Advanced Device Commands.

Aplicaţia va selecta automat manometrul principal pentru rezervor, în cazul în care 
rezervorul are mai mult de un manometru. Utilizatorii pot selecta ulterior un alt 
manometru pe care să opereze, făcând clic pe semnul „+” din dreptul rezervorului şi 
selectând funcţia manometrului.

BA00396G_0037

1.

2.
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10.2 Trimiterea comenzilor
Selectaţi rezervorul din lista de pe panoul din stânga. Amplasaţi rezervorul cu simbolul 
„+” (selectaţi manometrul într-o configuraţie cu mai multe manometre).
Comenzile suportate de manometru vor fi disponibile.

BA00396G_0038

Selectaţi comanda corespunzătoare din listă.

Setaţi parametrii necesari şi faceţi clic pe buton pentru a trimite comanda.
Informaţiile referitoare la progresul funcţionării manometrului vor fi raportate prin 
intermediul panoului din partea de jos a ferestrei.

1.

2.

3.
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10.3 Funcţiile de imersare
Acestea se aplică, în general, pentru seria Enraf 854 de manometre cu servoacţionare pentru 
rezervoare, după cum se observă în imaginea de mai jos.

BA00396G_0040

10.3.1 Modul de măsurare a produsului
• Trimite elementul manometrului I1.
• Afişează starea manometrului pe tot parcursul.
• Manometrul va rămâne la I1 până când utilizatorul dă o altă comandă.

10.3.2 Imersare pentru măsurarea densităţii 
Aceasta are două opţiuni:
• Profil rezervor
• Profil de interfaţă

Selectaţi opţiunea corectă şi faceţi clic pe butonul Apply.
Comanda va fi executată.

10.3.3 Modul de măsurare a apei 
• Trimite elementul manometrului I3.
• Afişează starea manometrului pe tot parcursul.
• Manometrul va rămâne la I3 până când utilizatorul dă o altă comandă.
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10.4 Funcţiile camerei de ardere

10.4.1 Testul de blocare
Blochează camera de ardere la un nivel specificat, după cum se poate observa în figura de 
mai jos.

BA00396G_0041

• Utilizează elementul MZ pentru a seta nivelul de blocare, urmat de comanda LT.
• Utilizatorul trebuie să furnizeze nivelul la care va fi blocată camera de ardere.

10.4.2 Deblocare
• Deblochează manometrul din poziţia de blocare sau de calibrare.
• Trimite elementul manometrului UN.
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10.5 Verificarea calibrării
Verifică calibrarea instrumentului. Camera de ardere va fi ridicată în camera de calibrare a 
manometrului.

BA00396G_0042

• Utilizează elementul manometrului CA.
• Manometrul va rămâne în modul de calibrare până când utilizatorul va da altă comandă.
• Memorează şi afişează nivelul de pornire.
• Afişează diferitele modificări de stare care apar.
• Apăsaţi butonul de deblocare pentru ca camera de ardere să revină în modul de măsurare 

a produsului.
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10.6 Întreţinere
Setează registrele aparatului de măsură pentru a ajusta configurarea dispozitivului.

BA00396G_0043

10.6.1 Setarea manometrului la o nouă tijă de nivel
Dacă manometrul indică o valoare diferită de cea măsurată manual cu tija de către operator, 
este normal să realiniaţi manometrul la valoarea indicată de tija operatorului.
Utilizatorul trebuie să furnizeze noua valoare indicată de tijă şi parola pentru a accesa 
manometrul.
Această funcţie utilizează o întreagă secvenţă de elemente ale manometrului, după cum 
urmează:

Setarea nivelului parolei folosind elementul W2 al manometrului.

Setarea nivelului de referinţă utilizând elementul RL al manometrului.

Acceptarea nivelului de referinţă utilizând elementul AR al manometrului.

Ieşirea şi reiniţializarea manometrului cu ajutorul elementului EX al manometrului.

Selectarea rezervorului care necesită o nouă tijă de nivel.

Introducerea noului nivel al manometrului.

Apăsarea butonului Dip.

În timp ce are loc secvenţa de acţiuni de mai sus, se afişează starea fiecărei tranziţii.

Atunci când comanda EX este emisă în cele din urmă, datele manometrului pot 
dispărea pentru o perioadă scurtă de timp, în timp ce manometrul se reiniţializează. 
După reiniţializare, nivelul manometrului ar trebui să indice noua valoare.

1.

2.

3.

4.

5.

6.

7.
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10.7 Elementele manometrului
Această funcţie se aplică numai pentru manometrele Enraf şi Motherwell.

BA00396G_0044

NOTIFICARE
Utilizarea acestei funcţii necesită cunoaşterea echipamentului de măsurare specific şi 
a configuraţiei acestuia.
Se recomandă ca aceasta să fie utilizată numai de persoane competente.

Această caracteristică permite utilizatorului să citească/să scrie oricare dintre elementele de 
configurare a manometrului. Pentru a citi un element, introduceţi elementul respectiv şi 
faceţi clic pe Apply, iar răspunsul va fi afişat. Pentru a scrie un element, introduceţi 
elementul şi introduceţi datele pe care doriţi să le scrieţi, apoi faceţi clic pe Apply. 

10.7.1 Elementele manometrului Enraf

Conversia unităţilor

Această filă suportă conversiile de unităţi din unităţile afişate în Tankvision Professional în 
unităţile pe care manometrul este configurat să le înţeleagă. Pentru a evita confuziile, 
recomandăm ca dimensiunile afişate să fie modificate pentru a se potrivi cu cele utilizate de 
manometru, dacă este posibil. În acest fel, formatul utilizat pentru setările efectuate prin 
intermediul unui terminal Enraf portabil (PET) va corespunde direct cu formatul care trebuie 
utilizat în fila Gauge Items.

Citirea unei solicitări

Pentru a citi o solicitare nu este necesar să se furnizeze date privind elementele 
manometrului. Datele vor fi convertite în unităţile de afişare ale sistemului curent înainte de 
a fi afişate.
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Formatul datelor

Atunci când setează elementele, utilizatorul trebuie să introducă valoarea datelor în 
formatul exact care este adecvat pentru dimensiunile/unităţile selectate, cu semnul +/- şi 
numărul corespunzător de cifre înainte şi după virgulă. În cazul în care nu sunteţi sigur de 
formatul corect, citiţi mai întâi valoarea curentă a elementului dorit de pe manometru, 
lăsând gol la Item Data. 
Valoarea de răspuns de la manometru va fi afişată în formatul corespunzător dimensiunilor/
unităţilor utilizate. Folosiţi apoi acelaşi format ca şi răspunsul returnat pentru a seta datele 
elementului la noua valoare dorită. Semnul egal „=” trebuie să preceadă valoarea datelor 
atunci când setaţi elementele.

Sunt acceptate următoarele Dimensiuni/Unităţi

Tastă:
• ± caracter (+/-)
• N număr
• . virgulă zecimală

Nivel

Unităţi Format

mm ± N N N N N N . N (implicit)

m ± N N N . N N N N

ft ± N N N . N N N N

in ± N N N N N . N N

f-i-s ± N N ' N N " N N

Temperatură

Unităţi Format

°C ± N N N . N N (implicit)

°F ± N N N . N N

Densitate

Unităţi Format

kg/l ± N N . N N N N N (implicit)

kg/m³ ± N N N N N . N N

lb/ft3 ± N N N . N N N N

° API ± N N N N . N N N

Presiune

Unităţi Format

Bari ± N N . N N N N N (implicit)

Pa ± N N N N N N . N

kPa ± N N N N . N N N

lb/in² ± N N N . N N N N
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10.7.2 Elementele manometrului Motherwell
Elementele manometrului Motherwell nu beneficiază de aceeaşi facilitate de conversie a 
unităţilor. Datele introduse în câmpul Gauge Item Data sunt transmise textual aparatului. 
Trebuie să consultaţi documentaţia Motherwell pentru a determina formatul exact al 
datelor.
În cazul manometrelor Motherwell, puteţi fie specifica un cod de articol hexazecimal din 2 
cifre, aşa cum este descris în documentaţia manometrelor Motherwell, fie puteţi utiliza un 
cod „prescurtat” pentru anumite elemente de date.

Cod prescurtat Descriere

UR Nivel de referinţă superior

RL Nivel de referinţă

HH Nivel de alarmă extrem de ridicat

HA Nivel de alarmă ridicat

LA Nivel de alarmă scăzut

LL Nivel de alarmă extrem de scăzut
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11 Gruparea rezervoarelor
Sistemul oferă o gamă completă de instrumente şi utilităţi pentru organizarea şi gruparea 
rezervoarelor în funcţie de cerinţele utilizatorului.
Toate funcţiile de grupare a rezervoarelor sunt în general disponibile din modulul Tank 
Grouping.

Gruparea este în general organizată în grupuri statice şi dinamice.
• Grupurile statice pot fi organizate după:

– Produs
– Grup de produse 
– Grup de rezervoare definit de utilizator 

• Grupurile dinamice sunt definite automat prin criteriile lor intrinseci.

Afişajul modulului Tank Grouping cuprinde o fereastră de dialog cu mai multe file. Fiecare 
filă reprezintă unul dintre modurile de grupare a rezervoarelor.
Accesul la anumite funcţii de grupare a rezervoarelor este protejat prin parolă. Acolo unde 
este necesar, vi se va cere să vă autentificaţi.

11.1 Configurarea şi utilizarea unei grupe statice
Încărcaţi modulul Tank Grouping făcând clic pe Quick View → Tank Groups din bara de 
meniu a grupurilor.

Faceţi clic pe fila Static Groups. Se deschide fereastra Tank Groups, aşa cum se observă 
în imaginea de mai jos:

BA00396G_0045

Apăsaţi butonul Add.... Este afişat ecranul Grupuri statice, după cum se observă în 
imaginea de mai jos:

1.

2.

3.
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BA00396G_0046

Introduceţi numele grupului şi apoi evidenţiaţi o secţiune a rezervoarelor disponibile 
pentru a le adăuga la grup. Pentru a le elimina din grup, faceţi clic pe ele a doua oară 
pentru a elimina evidenţierea. Pentru a salva grupul, faceţi clic pe butonul OK. Pentru a 
elimina orice modificare, faceţi clic pe butonul Cancel.

După ce reveniţi la fereastra Tank Groups, salvaţi modificările aduse tuturor grupurilor 
făcând clic pe butonul OK. Pentru a elimina modificările, faceţi clic pe butonul Cancel.
Grupul static poate fi utilizat acum prin selectarea lui din meniul Static Groups din bara 
de meniu a grupurilor.

11.1.1 Editarea unui grup static existent
Încărcaţi modulul de grupare a rezervoarelor făcând clic pe Quick View → Tank Groups 
din bara de meniu a grupurilor.

Faceţi clic pe fila Static Groups.

Selectaţi grupul care urmează să fie modificat şi apăsaţi butonul Edit... Este afişat 
ecranul Grupuri statice, după cum se observă în imaginea de mai jos:

BA00396G_0047

Faceţi clic pe rezervoarele disponibile pentru a le adăuga sau a le elimina din grup. Toate 
rezervoarele care sunt evidenţiate fac parte din grup.

Pentru a salva grupul, faceţi clic pe butonul OK. Pentru a elimina orice modificare, faceţi 
clic pe butonul Cancel.

4.

5.

1.

2.

3.

4.

5.
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Pentru a salva modificările la toate grupele, faceţi clic pe butonul OK. Pentru a elimina 
modificările, faceţi clic pe butonul Cancel.
Grupul static poate fi utilizat acum în forma sa modificată, selectându-l din meniul 
Static Groups din bara de meniu a grupurilor.

11.1.2 Ştergerea unui grup static existent
Încărcaţi modulul de grupare a rezervoarelor făcând clic pe Quick View → Tank Groups 
din bara de meniu a grupurilor.

Faceţi clic pe fila Static Groups.

Selectaţi grupul de rezervoare care urmează să fie şters din lista de grupuri.

Apăsaţi butonul Delete.

11.2 Gruparea produselor
Sistemul oferă utilizatorului posibilitatea de a vizualiza rezervoarele care conţin un anumit 
produs.

11.2.1 Utilizarea unei grupări de produse
Încărcaţi modulul de grupare a rezervoarelor selectând Quick View → Tank Groups.

Faceţi clic pe fila Product Groups.
Se va afişa lista de produse disponibile:

BA00396G_0048

Dacă există multe produse, este posibil să fie necesare bare de derulare a ferestrelor 
pentru a localiza produsul vizat.

Selectaţi produsul vizat din listă.
Vor fi enumerate rezervoarele care conţin produsul vizat la momentul respectiv.

Grupul de produse poate fi utilizat selectându-l din meniul Product Groups de pe bara 
de meniu a grupurilor.

Produsul care urmează să fie utilizat pentru a filtra rezervoarele poate fi, de asemenea, 
utilizat selectându-l din meniul Product Groups de pe bara de meniu a grupurilor. Sunt 
enumerate numai produsele care sunt alocate în prezent rezervoarelor şi sunt ordonate 
în funcţie de utilizare (cel care este alocat mai întâi la cele mai multe rezervoare). În 
cazul în care există mai mult de 12 produse alocate în prezent rezervoarelor, sunt incluse 

6.

1.

2.

3.

4.

1.

2.

3.

4.

5.
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doar cele mai utilizate 12 produse, împreună cu o intrare finală care afişează un ecran de 
selecţie a produselor:

BA00396G_0123

Se poate selecta un produs făcând clic pe săgeată, ceea ce va afişa o listă cu toate 
produsele care sunt alocate rezervoarelor (din nou, sortate în ordinea utilizării). 
Alternativ, se poate introduce numele produsului dorit. Pe măsură ce se introduce 
numele produsului, se afişează o listă redusă de produse care corespund textului 
introdus:

BA00396G_0124

11.3 Totalizator grup de produse
Se deschide Product Group Totaliser de pe pagina de pornire, View → Product Group 
Total.
Product Type Totaliser afişează volumele totalizate pentru grupurile de produse.
Pentru detalii, consultaţi ilustraţia de mai jos.

BA00396G_0049

11.4 Gruparea dinamică
Sistemul oferă în prezent o funcţie de bază de grupare dinamică care permite utilizatorului 
să vizualizeze rezervoarele care se conformează anumitor criterii dinamice, de exemplu, 
rezervoare în mişcare.
Atunci când este utilizat un grup dinamic, pe măsură ce rezervoarele nu mai corespund 
criteriilor, acestea vor fi eliminate automat din afişare.
În prezent, numărul de grupuri dinamice disponibile este fix. Aceste grupuri sunt definite 
automat de sistem.

6.
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11.4.1 Utilizarea unei grupe dinamice
Încărcaţi modulul de grupare a rezervoarelor făcând clic pe butonul corespunzător din 
bara de instrumente.

Faceţi clic pe fila Dynamic Groups Tab.
Se va afişa lista grupurilor dinamice disponibile:

BA00396G_0050

Selectaţi un grup dinamic.
Se vor afişa rezervoarele care se conformează criteriilor pentru grupul dinamic 
specificat. De exemplu, Moving Tanks reprezintă orice rezervor care se deplasează în 
orice direcţie, iar Receipt Tanks reprezintă acele rezervoare care sunt în curs de 
umplere.

11.5 Setaţi rezervoarele de urmărit
Încărcaţi modulul de grupare a rezervoarelor selectând Quick View → Tank Groups. 
Selectaţi fila Quick View.
Fila Quick View arată rezervoarele care vor fi afişate pe pagina de pornire, după cum se 
observă în figura de mai jos.

BA00396G_0051

1.

2.

3.

1.
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Evidenţiaţi rezervoarele pe care doriţi să le vizualizaţi pe ecran. Evidenţierea se comută 
făcând clic pe rezervoarele din listă. 
Butonul Invert va comuta evidenţierea pe toate rezervoarele, astfel încât rezervoarele 
care au fost selectate devin deselectate şi invers.

Pentru a selecta toate rezervoarele simultan, apăsaţi butonul Select All urmat de 
butonul OK pentru a afişa toate rezervoarele.

Pentru a de-selecta toate rezervoarele simultan, apăsaţi butonul Deselect All urmat de 
butonul OK pentru a minimiza toate rezervoarele.

Apăsaţi butonul OK pentru a afişa rezervoarele selectate.

2.

3.
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12 Ajutor şi diagnosticare
Sistemul conţine o funcţie de ajutor şi diagnosticare pentru a ajuta utilizatorul.
O mare parte din ajutor apare în meniul Help de pe pagina de pornire.
Opţiunile disponibile în meniul Help sunt detaliate în următoarele secţiuni.

12.1 Diagnosticare
Pentru a vizualiza semnificaţia codurilor de diagnosticare (numere DN) care apar pe afişajul 
rezervorului, faceţi dublu clic pe acestea pentru a lansa modulul Coduri de diagnosticare.

12.1.1 Lansarea modulului de diagnosticare
Selectaţi opţiunea Diagnostics din meniul Help de pe bara de meniuri a paginii principale de 
pornire. Consultaţi figura de mai jos.

BA00396G_0052

Prima coloană enumeră codul de diagnosticare, a doua coloană conţine o scurtă definiţie, iar 
ultima coloană face trimitere la un nume de fişier care conţine informaţii mai detaliate 
despre cauzele potenţiale ale diagnosticării şi acţiunile recomandate pentru identificarea şi 
remedierea oricărei probleme asociate. Panoul din dreapta afişează conţinutul fişierului.

12.1.2 Imprimarea listei de diagnosticare
Modulul de diagnoză poate pregăti o documentaţie tipărită fie a codurilor de eroare specifice, 
fie a unei liste de coduri de eroare şi o scurtă descriere a acestora.

Din meniul ferestrei Diagnostics alegeţi:
• File → Print → Diagnostics List
• File → Print → Recommended Action
• File → Print Preview → Diagnostics List
• File → Print Preview → Recommended Action
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Comenzile Print vor trimite raportul direct la imprimanta implicită din Windows. Comenzile 
Print Preview vor prezenta un ecran ca cel de mai jos.

BA00396G_0053

12.1.3 Lansarea fişierului de acţiune recomandată
Pentru a afla mai multe informaţii despre codul de diagnosticare, faceţi dublu clic pe rândul 
de interes.
Aceasta va lansa Windows WordPad şi va deschide fişierul de acţiuni recomandate.
Consultaţi ilustraţia de mai jos pentru un exemplu în acest sens.

BA00396G_0054
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12.2 Versiuni
Selectaţi Help → Versions din meniurile de pe pagina de pornire.
Afişajul de mai jos prezintă detalii despre fişierele executabile care alcătuiesc sistemul de 
măsurare a rezervoarelor.

BA00396G_0055

Utilizaţi barele de derulare pentru a vizualiza detaliile fiecărui fişier din listă. 

12.2.1 Imprimarea unui raport al versiunilor modulelor
Folosind funcţia de raportare încorporată în versiuni, poate fi generat un raport pe hârtie al 
informaţiilor afişate pe ecranul versiunilor. Selectaţi File → Print şi File → Print Preview 
pentru a face acest lucru.

BA00396G_0056
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12.3 Despre
Meniul Help din bara de meniu a paginii principale de pornire conţine o opţiune denumită 
About.
Atunci când este selectată, această opţiune de meniu va încărca un modul de afişare care va 
arăta numărul general al versiunii aplicaţiei dumneavoastră, detaliile licenţei şi persoana/
compania pe numele căreia este înregistrată aplicaţia Tankvision Professional, inclusiv o 
declaraţie privind drepturile de autor.

BA00396G_0210

Aceste informaţii sunt foarte importante pentru orice apel de asistenţă tehnică adresat 
furnizorului dumneavoastră. Una dintre primele întrebări la orice apel de solicitare a 
asistenţei va fi, în mod inevitabil, cine este utilizatorul înregistrat şi numărul de 
licenţă/numărul de fabricaţie al aplicaţiei complete.
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13 Tendinţe
Caracteristici cheie
• Afişări multiple simultane pe un singur grafic 
• Axe independente sau partajate pentru fiecare variabilă de proces 
• Grilă de afişare pentru o mai bună citire 
• Cursor de date pentru citirea valorilor tendinţelor 
• Suportă dimensiuni dinamice multiple 
• Explorarea datelor în jos cu funcţia Zoom 
• Derulare înainte şi înapoi în timp 
• Extinderi ale axei Y programabile de către operator 
• Bază de timp programabilă de către operator 
• Posibilitatea de a salva mai multe şabloane de tendinţe
• Posibilitatea de a „publica” şabloane de tendinţe pentru a le utiliza pe alte PC-uri din reţea
• Vizualizarea simultană a mai multor şabloane de tendinţe

13.1 Înregistrarea tendinţelor şi a datelor
Sistemul este livrat standard cu un pachet de înregistrare a tendinţelor. Un serviciu Trend 
Logger va înregistra datele privind tendinţele pe hard disk-ul sistemului şi va furniza aceste 
date clienţilor.
Există trei interfeţe de utilizator pentru afişarea datelor de tendinţă:
• Real-time (→ ä 58) – Afişează parametrii actuali de măsurare ai rezervoarelor pe o 

perioadă de maximum 12 ore.
• Historical (→ ä 60) – Oferă o diagramă grafică a parametrilor de măsurare a 

rezervoarelor.
• Historical (Tabular) (→ ä 61) – Indică „cifrele" din graficul istoric, pentru exportul către 

alte sisteme.

13.2 Tendinţe în timp real
Funcţia de tendinţe în timp real combină capacitatea de a revizui date istorice privind 
tendinţele din ultimele 12 ore cu date actuale în timp real.

13.2.1 Iniţierea tendinţelor în timp real
Fie:
• Faceţi clic pe butonul barei de instrumente  de pe pagina de pornire.
• Selectaţi View → Real-time Trending din meniurile de pe pagina de pornire.
• Selectaţi Real-time trending din meniurile Service Manager.
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Se deschide ecranul cu parametrii tendinţelor, după cum se observă în imaginea de mai jos.

BA00396G_0126

La modul cel mai simplu, procesul de afişare a datelor privind tendinţele constă în selectarea 
parametrilor rezervorului pe care doriţi să îi vizualizaţi şi a perioadei de timp pentru care 
doriţi să vizualizaţi aceşti parametri. Vizualizarea tendinţelor în timp real este mai simplă 
decât celelalte ecrane, deoarece intervalul de timp pentru vizualizare este întotdeauna de la 
momentul actual până la un număr variabil de ore în trecut.

13.2.2 Date grafice în timp real
Primul parametru introdus este perioada pe care doriţi să o reprezentaţi pe grafic, după cum 
se observă în figura de mai jos. 

BA00396G_0173

Interval este numărul de ore din trecut pe care doriţi să le vizualizaţi; maximul posibil fiind 
de 12 ore. Plot Interval este timpul (în secunde) dintre punctele de date succesive de pe 
grafic; intervalul maxim este de 900 de secunde - de obicei, nu este nevoie de un interval de 
reprezentare grafică mai fin de peste 30 de secunde decât dacă aţi modificat configurarea 
serviciului de evaluare a tendinţelor.

13.2.3 Alte opţiuni de configurare
Pentru detalii despre opţiunile comune de configurare, consultaţi → ä 63.

Opţiuni de sistem redundant

Într-o configuraţie cu server redundant, atunci când se execută clientul de evaluare a 
tendinţelor pe un sistem client, există opţiunea suplimentară de a alege serverul sursă, după 
cum se observă în figura de mai jos. Puteţi alege oricare dintre perechile de servere 
redundante sau automate, care utilizează serverul la care este conectată în prezent pagina 
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de pornire ca sursă de date. În plus, opţiunea Attempt to patch missing data using the 
other server poate fi utilizată dacă serverul selectat are un set de date incomplet pentru 
perioada de realizare a diagramei.

BA00396G_0174

Mecanismul de corecţie a lacunelor completează în setul de date al fiecărui server folosind 
datele de la celălalt server. Dacă ambele servere au lacune în datele lor în acelaşi timp, ceea 
ce este tipic pentru o problemă a unui instrument de pe teren, atunci golul rămâne. 
Facilitatea este utilă doar atunci când unul dintre servere a fost indisponibil în timpul 
perioadei de reprezentare grafică a tendinţelor.

13.3 Tendinţe istorice
Tendinţele istorice sunt similare cu tendinţele în timp real, în sensul că scopul lor este de a 
genera un grafic al datelor de măsurare a rezervoarelor pe o perioadă de timp. Cu toate 
acestea, diferenţa constă în faptul că datele prezentate nu sunt instantanee (adică nu se 
derulează spre stânga) şi nu există o limită de 12 ore pentru perioada care poate fi 
reprezentată grafic.

13.3.1 Iniţierea tendinţelor istorice
Fie:
• Faceţi clic pe butonul barei de instrumente  de pe pagina de pornire.
• Selectaţi View → Historical Trending din meniurile de pe pagina de pornire.
• Selectaţi Historical trending din meniurile Service Manager.

Se deschide ecranul cu parametrii tendinţelor, după cum se observă în imaginea de mai jos.

BA00396G_0139
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13.3.2 Date istorice de reprezentare grafică
Pentru a identifica perioada datelor care urmează să fie incluse în grafic, trebuie specificate 
o oră de început, o oră de sfârşit şi intervalul de reprezentare grafică. Ora de început şi 
de sfârşit se explică de la sine, iar intervalul de reprezentare grafică determină timpul dintre 
punctele învecinate de pe diagramă. Intervalul maxim de reprezentare grafică este de 900 
de secunde.

BA00396G_0176

Trasarea unor seturi mari de date durează mult timp. Datele pentru o lună, 
reprezentate grafic la intervale de 5 secunde pentru 20 de câmpuri, vor implica o 
durată îndelungată de compilare pentru graficul dumneavoastră.

Configurarea implicită a serverului de tendinţe este de a şterge datele de tendinţe după 
90 de zile. Selectarea unei perioade de timp mai vechi decât datele disponibile pe server 
va avea ca rezultat un grafic gol.

13.3.3 Alte opţiuni de configurare
Pentru detalii despre opţiunile comune de configurare, consultaţi → ä 63.

Opţiuni de sistem redundant

În cazul în care sistemul este unul redundant, sunt disponibile câteva opţiuni suplimentare, 
prezentate în figura de mai jos.

BA00396G_0177

Este posibilă selectarea unui Server specific ca sursă de date - sau automat, care va alege 
orice server pe care pagina de pornire îl foloseşte în prezent ca sursă de date. Opţiunea 
Attempt to patch missing data using the other server permite ca golurile din datele 
serverului sursă să fie fi completate cu date recuperate din cohorta redundantă.

13.4 Tendinţe istorice (tabel)
Pentru majoritatea scopurilor, sunt suficiente vizualizările grafice ale datelor privind 
tendinţele furnizate de funcţia În timp real şi Istorică pentru vizualizarea activităţilor dintr-
un parc de rezervoare. În cazul în care este necesară o analiză mai aprofundată a datelor de 
bază, este furnizată vizualizarea tabelară, a cărei funcţie principală este aceea de a permite 
exportul datelor într-un format în care acestea pot fi utilizate de alte sisteme.
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13.4.1 Iniţierea tendinţelor istorice (tabel)
Fie:
• Faceţi clic pe butonul barei de instrumente  de pe pagina de pornire.
• Selectaţi View → Historical Trending (Table) din meniurile de pe pagina de pornire.
• Selectaţi Historical trending (table) din meniurile Service Manager.

Se deschide ecranul cu parametrii tendinţelor, după cum se observă în imaginea de mai jos.

BA00396G_0179

13.4.2 Selectarea datelor privind tendinţele istorice pentru 
vizualizarea tabelară

Procesul de selecţie pentru datele tabelare este foarte similar cu cel al vizualizării grafice 
(→ ä 61), singura diferenţă fiind că puteţi alege modul în care sunt raportate datele.

Stocarea tendinţelor datelor de măsurare şi control al nivelului din rezervor

Datele privind tendinţele sunt colectate şi stocate pe calculatorul server, de către serviciul de 
tendinţe. Serviciul îndeplineşte două sarcini: adună datele de măsurare şi control al nivelului 
din rezervor în direct şi le stochează în fişiere pe computer şi transmite datele pe care le-a 
adunat aplicaţiilor client atunci când i se solicită acest lucru.

Metoda utilizată pentru colectarea datelor constă în scanarea periodică a datelor disponibile 
de măsurare şi control al nivelului din rezervoare (de obicei, la fiecare 10 secunde) şi în 
înregistrarea doar a parametrilor care s-au modificat de la ultima scanare de 10 secunde. 
Dacă luăm ca exemplu nivelul produsului dintr-un rezervor, atunci când nivelul produsului 
nu s-a modificat de la ultima scanare, nu se va efectua nicio înregistrare pentru rezervor la 
scanarea respectivă. Acest lucru are consecinţe asupra datelor prezentate în vizualizarea 
istorică tabelară.

Selectarea datelor istorice

Opţiunile comune de selectare a datelor privind tendinţele se aplică acestei vizualizări a 
datelor privind tendinţele, consultaţi → ä 63. În plus, există 3 opţiuni prezentate la alegerea 
selecţiei datelor istorice privind tendinţele, care determină variaţia datelor returnate în 
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vizualizarea tabelară. Selectarea acestora ar putea influenţa valoarea statistică a 
informaţiilor.

BA00396G_0180

Vizualizare tabelară a datelor privind tendinţele istorice

13.5 Configurarea comună a tendinţelor
Multe dintre tehnicile utilizate pentru proiectarea unui grafic de tendinţe sunt comune atât 
pentru vizualizările în timp real, cât şi pentru cele istorice şi, într-o anumită măsură, pentru 
vizualizările tabulare ale datelor privind tendinţele. Aceste tehnici sunt descrise aici.

13.5.1 Axe comune
În cazul în care trebuie realizate reprezentări grafice pentru informaţii conexe, este adesea 
de dorit să le reprezentaţi grafic pe o axă comună, astfel încât să se poată compara valorile 
liniei de reprezentare grafică în diferite momente de timp. De exemplu, dacă nivelul 
produsului şi nivelul apei libere dintr-un rezervor ar fi reprezentate grafic împreună, ambele 
ar putea fi reprezentate pe aceeaşi axă, deoarece se aşteaptă ca nivelul apei să fie ceva mai 
scăzut decât nivelul produsului. În cazul în care sunt reprezentate pe axe separate şi se 
utilizează opţiunea de scalare automată, nivelul apei ar fi în mod normal o linie orizontală 
plană în centrul graficului, iar nivelul produsului ar fluctua deasupra şi sub aceasta. Dacă se 
utilizează o axă de nivel partajată, nivelul liber al apei va fi afişat în partea de jos a 
reprezentării grafice, iar nivelul produsului va fluctua deasupra acestuia şi va fi pe scara cu 
valorile.

Opţiune Descriere

Logged Values Only Variabilele de proces care nu conţin o valoare în înregistrarea datelor sunt lăsate goale.

All Implied Values Înregistrările goale care apar în selecţia de date Logged Values Only sunt completate 
cu ultima valoare cunoscută de la scanările anterioare.

Interpolated Values Înregistrările goale care apar în selecţia de date Logged Values Only sunt completate 
cu o valoare sintetizată prin interpolare liniară din valorile reale anterioare şi 
ulterioare acestei înregistrări de timp.
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13.5.2 Adăugarea unei axe partajate
Pentru a crea o axă partajată, faceţi clic pe Add. Se creează astfel o nouă axă, iniţial de tip 
nivel şi denumită New Axis, după cum se observă în imaginea de mai jos.

BA00396G_0181

Schimbaţi numele axei introducând un nume adecvat în caseta de text Caption şi selectaţi 
tipul adecvat pentru axa dumneavoastră. Dacă lăsaţi bifată opţiunea Auto Scale, axa va fi 
redimensionată pentru a completa cât mai mult posibil din zona de reprezentare grafică 
pentru a adapta intervalul de valori din datele privind tendinţele. Acest lucru poate face ca 
fluctuaţiile mici să pară mult mai mari decât sunt! Dacă decideţi să nu scalaţi automat axa, 
debifaţi opţiunea, dar introduceţi valori minime şi maxime adecvate pentru axă.

13.5.3 Adăugarea de câmpuri
Nu există nicio limită în ceea ce priveşte numărul de câmpuri care pot fi afişate, însă 
adăugarea unui număr mare la acelaşi şablon de tendinţe poate îngreuna interpretarea 
datelor. Este mai bine să creaţi mai multe şabloane cu mai puţine elemente de tendinţe pe 
fiecare.

Faceţi clic pe butonul Add Field pentru a adăuga un element de tendinţă, după cum se 
observă în imaginea de mai jos.

BA00396G_0182

Selectaţi un rezervor din lista derulantă, apoi selectaţi variabila de proces pentru rezervorul 
pentru care se va stabili tendinţa.

Dacă este disponibilă, se poate utiliza o Shared Axis pentru una sau mai multe 
variabile de proces, bifând caseta şi selectând axa partajată necesară din lista 
derulantă. N.B. În listă vor fi afişate numai axele partajate relevante pentru variabila 
de proces ale cărei tendinţe sunt evaluate, de exemplu, nu va fi afişată o axă de 
temperatură pentru un proces de evaluare a tendinţelor nivelului.

Dacă este necesar, se pot introduce valori maxime şi minime opţionale pentru axa y. Cu cât 
intervalul dintre valorile minime şi maxime este mai mic, cu atât pot fi vizualizate mai multe 
detalii. Pentru a introduce valori maxime şi minime, este necesar să vă asiguraţi mai întâi că 
nu se utilizează o axă partajată şi să debifaţi caseta Auto pentru câmpul respectiv.
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Repetaţi procedura pentru a adăuga şi alte câmpuri de tendinţe.

Faceţi clic pe butonul  pentru a elimina un câmp de tendinţă din listă. Figura de mai jos 
este un exemplu de şablon de tendinţe.

BA00396G_0184

Culoarea şi stilul liniei

Culoarea şi stilul fiecărei linii de grafic pot fi personalizate pentru o mai uşoară identificare. 
Faceţi clic pe butonul  de la capătul liniei pentru a deschide paleta de stil prezentată mai 
jos.

BA00396G_0186
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Selectaţi stilul şi culoarea pe care le doriţi şi faceţi clic pe butonul OK. Faceţi clic pe Use 
Defaults pentru a reveni la selecţia de stil implicită.
Afişarea tendinţelor va fi configurată pentru a afişa datele solicitate.

Vizualizarea graficului de tendinţe

După ce au fost configurate câmpurile, reprezentarea grafică poate fi afişată făcând clic pe 
butonul Back .

BA00396G_0188
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13.5.4 Găsirea unei valori privind o tendinţă
Valorile variabilelor de proces la un anumit moment pot fi determinate atunci când modul 
de selecţie al graficului nu este None. Pentru a schimba modul de selecţie al graficului, faceţi 
clic pe File pentru a reveni la ecranul Info şi selectaţi butonul Advanced…. Din fereastra care 
se deschide, selectaţi Selection Mode şi apoi modul de selectare dorit.

BA00396G_0189

BA00396G_0190

Aceasta va fi una dintre următoarele valori:
• Default – Foloseşte modul de selectare implicită (nu modifică culoarea şi stilul liniei, faceţi 

clic pe Use Defaults pentru a le seta la starea implicită).
• None – Nu este posibilă selectarea unui moment pe grafic şi nu se afişează valorile 

variabilelor de proces.
• Fixed Time – Se poate selecta un anumit timp pe grafic şi valorile variabilelor de proces 

corespunzătoare vor fi afişate în partea stângă a ecranului. Pe măsură ce sunt adăugate noi 
valori la grafic, linia care indică selecţia se va derula spre stânga, rămânând la acelaşi timp.

• Fixed Location – Se poate selecta un anumit timp pe grafic, iar valorile variabilei de proces 
corespunzătoare vor fi afişate în partea stângă a afişajului. Pe măsură ce sunt adăugate noi 
valori la grafic, linia care indică selecţia va rămâne în acelaşi loc, valorile variabilei de 
proces derulându-se pe lângă ea.

Dacă Selection Mode nu este None, selecţia curentă poate fi deplasată înainte şi înapoi în 
timp cu ajutorul tastelor săgeată la stânga şi la dreapta. Pentru a modifica selecţia cu o 
valoare mai mare, ţineţi apăsată tasta Shift în timp ce utilizaţi tastele săgeată stânga şi 
dreapta.
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13.5.5 Mărirea pentru a vizualiza mai în detaliu
Modulul de tendinţe permite utilizatorului să aprofundeze datele privind tendinţele şi să 
vizualizeze tendinţele mai detaliat. În cazul în care modul de selectare curent nu este None, 
este necesar să aduceţi mai întâi graficul în modul Zoom făcând clic pe butonul Zoom  de 
pe bara de instrumente.

Identificaţi zona din tendinţă pentru care aveţi nevoie de mai multe detalii

Folosind mouse-ul, desenaţi un chenar în jurul zonei de interes, indicând şi făcând clic cu 
butonul stâng al mouse-ului. În timp ce ţineţi apăsat butonul stâng al mouse-ului, trageţi 
indicatorul mouse-ului spre dreapta sau spre stânga şi veţi vedea cum apare un chenar de 
dimensiuni mari. Extindeţi acest chenar în jurul zonei de interes şi eliberaţi butonul mouse-
ului.
Sistemul va mări zona selectată. Veţi observa că apar bare de derulare orizontală şi verticală 
care vă permit să vă deplasaţi în jurul datelor la nivelul de zoom actual.
Puteţi mări şi mai mult, după cum este necesar, folosind aceeaşi tehnică.

13.5.6 Micşorare
Pentru a ieşi din modul Zoom şi a reveni la modul de Selectare, faceţi clic pe butonul Undo 
Zoom  de pe bara de instrumente. Acum veţi putea selecta un moment pe grafic dacă 
faceţi clic pe acesta, în loc să identificaţi o zonă care să fie mărită sau micşorată.

13.6 Şabloane de tendinţe
Criteriile de selecţie şi opţiunile de afişare pe care le specificaţi pentru a crea vizualizările 
datelor privind tendinţele pot fi salvate şi apoi rechemate pentru a recupera rapid efortul 
depus pentru conceperea vizualizărilor. Şabloanele conţin criteriile de selecţie, culoarea liniei 
şi informaţiile privind stilul şi pot fi salvate fie ca un fişier pe unitatea de hard disk a 
computerului, fie în mod centralizat în baza de date a sistemului de măsură şi control al 
nivelului din rezervor.

13.6.1 Salvarea unui şablon de tendinţe
La salvarea unui şablon, pe unitatea hard disk a computerului apare un fişier MTTRT. Odată 
salvat, un şablon va fi accesibil numai de pe computerul pe care a fost salvat.
Din pagina de parametri ai tendinţelor, faceţi clic pe Save sau Save As.

13.6.2 Publicarea unui şablon de tendinţe
Publicarea şablonului este similară cu salvarea acestuia, cu excepţia faptului că fişierul este 
memorat în baza de date de măsurare a rezervoarelor de pe server (sau servere, dacă 
sistemul este redundant). Odată publicat, şablonul este accesibil de la toate computerele din 
reţeaua sistemului de măsură şi control al nivelului din rezervor.
Din pagina de parametri de tendinţă, faceţi clic pe Publish.
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13.6.3 Deschiderea unui şablon de tendinţe
În pagina de parametri de tendinţă, faceţi clic pe Open.

BA00396G_0193

Sistemul oferă trei opţiuni:
• Recent Templates – O listă cu şabloanele utilizate recent.
• Computer – Oferă o facilitate de navigare pe hard diskul computerului pentru a căuta 
fişierele MTTRT salvate anterior.

• Published Templates – Prezintă o listă cu toate şabloanele care au fost publicate.

13.7 Imprimarea datelor privind tendinţele
Dacă este necesară o copie pe hârtie a graficului de tendinţă, după selectarea vizualizării 
dorite, selectaţi Print. Se va afişa o previzualizare a raportului, care poate fi direcţionat către 
o imprimantă.

Orice selecţie de timp sau zoom care a fost aplicată la vizualizarea grafică va fi 
reprodusă în imprimare.

13.8 Exportul datelor privind tendinţele
Modulele Real Time Trending şi Historical Trending (Graph) pot fi utilizate pentru a exporta 
date privind tendinţele fie în format grafic, fie în format .CSV, iar modulul Historical 
Trending (Table) poate fi utilizat doar pentru a exporta date privind tendinţele ca fişier .CSV. 
După ce a fost configurat un şablon pentru tendinţe, selectaţi Export de pe ecranul de 
configurare. 
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Pentru Real Time Trending şi Historical Trending (Graph), va fi afişat următorul ecran: 

BA00396G_0146

13.8.1 Exportul graficelor
Pentru a exporta datele sub formă de grafic, selectaţi Export Graph şi faceţi clic pe butonul 
Export.
Se va deschide fereastra de dialog de salvare a fişierului din Windows. Opţiunea Include 
selected variables va adăuga punctul de selecţie şi valorile reprezentărilor grafice la 
momentul respectiv, după cum se arată în imaginea mai jos.

BA00396G_0148
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13.8.2 Exportul datelor
Pentru a exporta doar valorile datelor, selectaţi Export Data.

Modulul Historical Trending (Table) poate exporta doar date, aşadar, nu există 
opţiunea de a exporta un grafic.

BA00396G_0194

Exportarea anteturilor

Dacă această opţiune este bifată, prima înregistrare de date din fişierul exportat va conţine 
antetele din tabel în loc de date.

Date

Această opţiune controlează modul în care sunt determinate valorile datelor; pentru mai 
multe informaţii privind opţiunile, consultaţi → ä 61.

Formatul datelor

Această opţiune controlează modul în care sunt formatate datele. 
• Exportul datelor privind tendinţele ca Formatted Data înseamnă că conţinutul fişierului 

CSV va corespunde exact datelor afişate în tabel (reţineţi totuşi că, dacă fişierul CSV este 
deschis cu Microsoft Excel, aplicaţia poate reformata datele înainte de a fi afişate).

• Exportul datelor privind tendinţele ca Raw Data in Base Units înseamnă că fişierul CSV va 
conţine datele brute din fişierul de date privind tendinţele.  Aceasta înseamnă că 
informaţiile de formatare (cum ar fi numărul de zecimale) şi traducerile valorilor (cum ar 
fi starea de alarmă) nu vor fi exportate, iar fişierul CSV va conţine doar date numerice. 

• Exportarea datelor privind tendinţele ca Raw Data este aceeaşi ca în cazul opţiunii 
anterioare, cu excepţia faptului că acele câmpuri care conţin date ce pot fi afişate folosind 
unităţi diferite (cum ar fi nivelurile, temperaturile etc.) vor avea valorile convertite folosind 
unităţile selectate pentru tipul de câmp respectiv.

Faceţi clic pe butonul Export, selectaţi un nume de fişier şi o locaţie şi apoi faceţi clic pe Save.
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13.9 Opţiuni
Prin selectarea butonului Options puteţi controla şi şterge Şabloanele publicate şi puteţi seta 
Opţiuni implicite pentru realizarea graficelor de tendinţe.

BA00396G_0152

13.9.1 Fixarea şabloanelor
Şabloanele pot fi fixate în partea de sus a listei pentru a putea fi localizate cu uşurinţă.

Există 2 moduri de a fixa şabloanele:
• Faceţi clic dreapta pe şablon şi faceţi clic pe Pin to list.
• Treceţi cu mouse-ul peste şablonul dorit şi faceţi clic pe pictograma de fixare.

Şabloanele pot fi eliminate din locul de fixare făcând clic pe pictograma de dezlipire, care este 
afişată permanent pe şabloanele fixate.

13.9.2 Ştergerea şabloanelor
Şabloanele publicate care nu mai sunt necesare pot fi şterse.
Pentru a şterge un şablon, faceţi clic pe şablon pentru a-l evidenţia şi faceţi clic pe butonul 
Delete. Se pot şterge mai multe şabloane în acelaşi timp.

BA00396G_0153

BA00396G_0154
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13.9.3 Opţiuni de reprezentare grafică
Fila Graphing permite utilizatorului să personalizeze aspectul urmelor implicite „Selection” 
şi „Series”.

BA00396G_0155

Selectare

• Colour – Selectaţi culoarea implicită a liniei verticale de selectare.
• Line Style – Selectaţi stilul implicit al liniei de selectare verticală.
• Selection Mode – Alegeţi modul de selecţie implicit pentru reprezentările grafice ale 

tendinţelor. Pentru mai multe detalii → ä 67.

Serie

Vizualizatorul de tendinţe este prevăzut cu o singură Serie implicită configurată. Setările 
pentru aceasta pot fi modificate după cum urmează:
• Colour – Selectaţi culoarea liniei reprezentate grafic pentru serie.
• Text Colour – Selectează culoarea utilizată pentru afişarea textului pe tastă.
• Line Style – Defineşte stilul liniei reprezentate grafic pentru serie.

Se pot adăuga serii suplimentare implicite, faceţi clic pe Add şi configuraţi în mod similar.
Dacă graficul dumneavoastră conţine mai mulţi parametri de măsurare a rezervoarelor decât 
cei pentru care aţi definit stiluri de serie implicite, modelul de valori implicite se repetă 
începând cu seria 1.
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14 Calculatorul de inventar
Sistemul este prevăzut în mod implicit cu un Calculatorul de inventar.
Scopul principal al Calculatorului de inventar este de a oferi utilizatorului un mijloc de a 
calcula inventarul rezervoarelor pentru condiţii care nu există în prezent.
De exemplu, ar putea fi utilizat ca un calculator pentru „ce se întâmplă dacă”, dacă un 
rezervor ar primi sau încărca X litri de produs, care ar fi condiţiile finale ale rezervorului.
Acesta poate fi utilizat ca un simplu instrument de planificare înainte de încărcarea şi/sau 
primirea produsului. 

14.1  Lansarea aplicaţiei calculatorului de inventar
Apăsaţi butonul din bara de instrumente a Calculatorului de inventar .
Se va încărca modulul Calculatorul de inventar. Consultaţi ilustraţia de mai jos pentru un 
exemplu în acest sens. Calculatorul de inventar este un afişaj cu mai multe file care cuprinde 
calculatorul simplu de rezervoare, calculatorul de operaţiuni de încărcare/recepţie, un 
convertor de unităţi de măsură şi un calculator de interpolare liniară.

BA00396G_0068

14.2 Calculatorul de rezervoare
Calculatorul de rezervoare oferă utilizatorului posibilitatea de a calcula inventarul 
rezervoarelor în condiţiile specificate de utilizator.

14.2.1 Vizualizarea datelor curente ale rezervorului
Selectaţi un rezervor din lista derulantă.
Se vor afişa datele curente de măsurare şi control al nivelului din rezervor şi de inventariere 
pentru rezervorul selectat, împreună cu tabelul API configurat la momentul respectiv pentru 
rezervor. Unele valori ale datelor depind de diferitele selecţii efectuate în casetele derulante 
şi este posibil să nu fie vizibile în anumite configuraţii.
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14.2.2 Introducerea criteriilor definite de utilizator
Utilizatorul poate introduce următoarele date:
• Nivelul produsului 
• Temperatura produsului 
• Densitatea produsului 
• Nivelul apei 
• Presiune
• Masa moleculară 
• Coeficientul de temperatură 
• Factor de corecţie a densităţii 
• Tabelul API 

Unele dintre câmpurile de date nu sunt întotdeauna aplicabile. Interfaţa cu utilizatorul 
introduce noi câmpuri de date pe măsură ce acestea sunt solicitate de setările curente de 
calcul.
Câmpurile care pot fi editate sunt marcate în mod clar pe afişaj pe un fundal alb.

Pentru a calcula datele, procedaţi după cum urmează:

Modificaţi unul dintre câmpurile editabile.
De exemplu, pentru a vizualiza inventarul rezervorului la un alt nivel de produs, este 
suficient să ştergeţi sau să suprascrieţi citirea nivelului curent cu cel nou.

Apăsaţi butonul Calculate .
Parametrii Inventar vor fi recalculaţi pentru noile date.

14.3 Calculatorul de operaţiuni
Calculatorul de operaţiuni oferă utilizatorului posibilitatea de a simula o recepţie sau o 
încărcare de produs din rezervor. Cu ajutorul acestui instrument puteţi estima nivelul ţintă 
pentru operaţiune şi îl puteţi utiliza pentru a seta o operaţiune simplă.

BA00396G_0156

Înainte de a introduce detaliile operaţiunii, selectaţi un rezervor din listă. Vor fi afişate 
condiţiile actuale ale rezervorului.

Selectaţi tipul de operaţiune care urmează să fie efectuată, încărcare (operaţiune de 
ieşire), recepţie (operaţiune de intrare), umplere sau golire.

Există mai multe metode de declarare a cantităţii operaţiunii, inclusiv prin mai multe 
volume, greutăţi şi mase diferite. În majoritatea cazurilor, puteţi declara cantitatea care face 

1.

2.

1.

2.
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obiectul operaţiunii şi ca o cantitate absolută sau relativă. Pentru o descriere mai 
cuprinzătoare a acestor opţiuni, consultaţi manualul Operaţiuni simple (BA01653G).

Introduceţi cantitatea care urmează să fie încărcată sau primită, cu excepţia cazului în 
care valoarea este deja dedusă din tipul de operaţiune.

Faceţi clic pe butonul Calculate  pentru a calcula o estimare a condiţiilor din rezervor 
după efectuarea operaţiunii. În cazul în care doriţi să efectuaţi operaţiunea calculată, 
puteţi introduce unele abateri de prealarmă şi să setaţi operaţiunea, pentru a începe 
operaţiunea în cauză. Funcţia de operaţiune simplă este documentată complet în 
manualul Operaţiuni simple (BA01653G).

Pentru a şterge formularul şi a-l reseta, utilizaţi butonul Clear .

14.4 Interpolare
Fila Interpolare este un instrument foarte simplu de calcul al interpolării liniare. Scopul său 
este de a permite utilizatorului să introducă date direct dintr-un set de diagrame de calibrare 
a rezervoarelor şi să calculeze volumul la un nivel necunoscut prin interpolare liniară.
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14.5 Conversia unităţilor
Fila de conversie a unităţilor conţine un instrument simplu care permite utilizatorului să 
convertească o valoare exprimată într-o unitate de măsură în valoarea corespunzătoare 
folosind unităţi diferite. 
Selectaţi mai întâi tipul de valoare din opţiunile din stânga. Apoi, utilizatorul poate selecta 
din lista derulantă unităţile de măsură ale valorii iniţiale şi valoarea numerică a acesteia, iar 
apoi poate selecta o altă unitate de măsură în care trebuie convertită valoarea. 

3.

4.

5.
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Faceţi clic pe butonul Calculate pentru a efectua conversia.

BA00396G_0158

Selectaţi tipul de valoare din opţiunile din stânga.

Selectaţi din lista derulantă unităţile de măsură ale valorii iniţiale.

Introduceţi valoarea numerică de convertit.

Selectaţi o altă unitate de măsură în care să fie convertită valoarea.

Faceţi clic pe butonul Calculate .

1.

2.

3.

4.

5.
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15 Controlerul de scanare
Starea de scanare/interogare a manometrelor individuale poate fi setată cu ajutorul 
instrumentului denumit controler de scanare.
Pentru a accesa controlerul de scanare, Tools → Scan Controller din meniul principal al 
paginii de pornire.
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Sunt afişate detaliile tuturor aparatelor de măsură configurate în baza de date, inclusiv 
starea de scanare curentă.
Din această pagină se poate seta starea de scanare a unuia sau mai multor aparate de măsură 
printr-o singură operaţiune.

Selectarea manometrelor

• Pentru a selecta un manometru, faceţi clic pe acesta în tabel.
• Pentru a selecta mai multe manometre, ţineţi apăsată tasta Control şi faceţi clic pe blocul 

de la începutul rândului pentru următorul aparat de măsură.
• Alternativ, faceţi clic pe butonul Select All pentru a selecta toate aparatele de măsură din 

baza de date.

Setarea stării de scanare

Pentru a seta starea de scanare, faceţi clic pe unul dintre butoanele din partea de sus a 
ecranului.

• Set Normal Scan
Setează toate manometrele evidenţiate în starea de interogare normală.

• Set Fast Scan
Setează toate manometrele evidenţiate în starea de interogare rapidă. Rata de interogare 
rapidă este determinată de Rata de intercalare a scanării rapide setată în Comms Monitor.

• Set Off Scan
Opreşte interogarea pentru toate manometrele evidenţiate. Acest lucru afectează orice 
Tankvision Multiscan, precum şi comunicaţiile DCC.

• Set Manual Scan
Setează toate manometrele evidenţiate în starea de interogare manuală. Manometrele vor 
fi interogate numai atunci când acest lucru este comandat de un operator.



Tankvision Professional NXA85 - System Operation Controlerul de scanare

Endress+Hauser 79

• Set Offline
Setează toate manometrele evidenţiate în modul Offline în comunicaţiile DCC. Acest lucru 
afectează doar comunicaţiile DCC, orice Datacons conectate vor continua să interogheze 
manometrele, dar Tankvision Professional nu va interoga Datacons.

Starea de scanare a tuturor manometrelor va fi actualizată automat în afişajul controlerului 
de scanare după orice acţiune.
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16 Întreţinerea TAD
Modulul de întreţinere (Tank Additional Data) are trei scopuri.
• Tank Mode – Fluctuaţiile nivelului sau volumului de produs al unui rezervor pot genera 

alarme de operaţiune neautorizată sau de furt. Aceste alarme pot fi dezactivate temporar 
pentru fiecare rezervor în parte, fără a fi necesară dezactivarea alarmei. De asemenea, 
rezervoarele pot fi comutate în modul fundal, în care datele rezervorului sunt interogate şi 
actualizate doar la scanarea de fundal.  Pentru mai multe informaţii, consultaţi → ä 81.

• Tank/Product Status – Modulul este utilizat pentru a specifica dacă sunt permise sau nu 
operaţiunile dintr-un rezervor pe baza stării rezervorului sau a produsului pe care îl 
conţine.

• Tank Pump – Se definesc pompele şi fiecare pompă poate fi alocată unui rezervor cu 
ajutorul modulului.

Modulul de Întreţinere TAD se află în Configuration → TAD Maintenence din meniurile de 
pe pagina de pornire.

16.1 Modul rezervorului

BA00396G_0160

Modurile rezervorului sunt utilizate pentru a permite operatorilor să declare că rezervorul de 
care sunt responsabili se află într-un anumit mod de utilizare. Modurile pot fi apoi utilizate 
pentru a controla modul în care sistemul tratează rezervoarele atunci când se află în aceste 
moduri. De exemplu, în cazul în care o unitate are o operaţiune regulată de golire a apei 
libere de pe fundul rezervoarelor, timp în care se preconizează că nivelul din rezervor va 
scădea, se poate crea un mod numit „Water Drain-off” (Golire apă) care, atunci când este 
setat, va suprima temporar alarmele de operaţiune neautorizată şi durează 2 ore.

Atunci când operatorii stabilesc că este necesară golirea apei pentru un anumit rezervor, se 
poate seta modul şi se poate începe golirea. După 2 ore, operatorilor li se va reaminti că se 
află în modul de golire prin intermediul vizualizatorului de evenimente de alarmă, iar atunci 
când vor seta rezervorul înapoi în modul static implicit, alarmele de operaţiune neautorizată 
vor fi reactivate automat la noul nivel. În consecinţă, operatorul nu are nevoie de autorizaţie 
de securitate pentru a modifica setările alarmelor de operaţiune neautorizată, dar i se poate 
permite să suprime temporar crearea de alerte de operaţiune neautorizată.

Există un mod fix Default Tank Mode care nu suprimă alarmele de operaţiune neautorizată 
sau de furt şi nici nu pune un rezervor în Background Mode. Acest mod nu poate fi şters sau 
modificat, dar poate fi redenumit pentru a se adapta preferinţelor dumneavoastră.
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16.1.1 Adăugarea unui mod al rezervorului
Făcând clic pe butonul Add, se va crea un Mod nou şi se vor configura următoarele atribute:
• Name - Oferă modului un identificator unic. Acest nume va fi utilizat pentru selectarea 

modului rezervorului.
• Description – Descriere opţională pentru modul rezervorului. Aceasta este vizibilă doar în 

cadrul ecranului de configurare.
• Alarms Suppressed – Când este bifat acest mod, rezervoarele care au fost setate în acest 

mod nu vor genera alarme de operaţiune neautorizată sau de furt.
• Background Mode – Dacă este bifat, rezervoarele care au fost setate în acest mod vor fi 

interogate pentru date numai în timpul scanării de fundal.
• Default Duration – O valoare diferită de zero indică faptul că suprimarea alarmelor de 

operaţiune neautorizată sau de furt prin punerea unui rezervor în modul de fundal este 
doar o măsură temporară. Dacă nu este dezactivat în timpul setat, se va declanşa o alarmă 
pentru a avertiza că rezervorul este încă în modul de suprimare/de fundal. Setaţi o 
perioadă de timp în minute (maxim 2880, echivalentul a 48 de ore) pentru a declanşa 
alarma după setarea modului. Dacă setaţi această valoare la 0, alarma de avertizare va fi 
dezactivată. Temporizatorul poate fi setat numai dacă este bifată opţiunea Alarms 
Suppressed şi/sau Background Mode.

• Exclude Sump from Inventory – Dacă este bifat, volumul rezervorului din bazinul de 
stocare introdus în ecranul Tank Metrics nu va fi inclus în calculele de inventar.

• Force product level to zero – Când este bifat, dacă valoarea aparatului de măsură nu este 
valabilă (număr DN) sau dacă aparatul de măsură indică nivelul de oprire inferior, nivelul 
produsului pentru rezervor va fi setat la 0 mm. Dacă este activat şi indicatorul Exclude 
Sump from Inventory, atunci nivelul va fi întotdeauna setat la 0 mm, indiferent de 
valoarea transmisă de manometru. Acest lucru este setat în mod normal pentru un mod al 
rezervorului în care se presupune că rezervorul este gol.

• Automatic Reversion to Default Tank Mode – Dacă este bifat, modul rezervorului va fi 
schimbat automat în modul implicit dacă nivelul produsului depăşeşte valoarea de 
referinţă Empty Tank Threshold pentru mai mult de 30 de secunde. Valoarea de prag 
este configurată în pagina Tank Metrics.

16.1.2 Modul de fundal
Rezervoarele aflate în Background Mode vor fi interogate pentru date numai la scanarea de 
fundal. Acest lucru poate fi util pentru a reduce resursele utilizate ale sistemului, de 
exemplu, pentru rezervoarele goale sau inactive.
Atunci când un rezervor se află în Background Mode, starea rezervorului pe pagina de 
pornire se va schimba în OFF SCAN.

Efectul asupra alarmelor

Atunci când un rezervor se află în modul de fundal, anumite alarme sunt suprimate.

NOTIFICARE
Pericol din cauza alarmelor dezactivate
Dacă alarma este activată în Alarm Configuration, modul de fundal va anula setarea şi nu va 
testa starea de alarmă. 
‣ Dacă o alarmă afectată este activă la setarea modului, atunci alarma se va dezactiva, 

eliminând-o astfel de pe afişajul vizualizatorului de evenimente de alarmă.

Această caracteristică este deosebit de utilă pentru unităţile interesate de reducerea 
numărului de alarme active prezente în Alarm Event Viewer.

Alarmele afectate sunt următoarele:

• Alarmă de nivel scăzut programabilă
• Alarmă de nivel extrem de scăzut programabilă
• Alarmă de nivel scăzut hardware
• Alarmă de nivel extrem de scăzut hardware
• Alarmă de temperatură ridicată programabilă
• Alarmă de temperatură scăzută programabilă
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• Orice alarmă programabilă definită de utilizator pe baza nivelurilor scăzute
• Orice alarmă programabilă definită de utilizator pe baza temperaturii
• Alarmă variabilă programabilă
• [Toate] Alarmele de debit
• Nivel ţintă atins 
• Alarmă plafon flotant
• Alarme de operaţiuni „simple” (nu operaţiuni complete)

– Prealarme 1 -4*
– Nivel ţintă depăşit*

Alarmele de operaţiune neautorizată şi de furt nu sunt suprimate prin setarea unui mod de 
fundal al rezervorului. Atunci când este setat acest mod, valorile de pornire sunt înregistrate, 
iniţializând aceste alarme. Alarmele vor fi în continuare evaluate atunci când se obţin noi 
niveluri, deşi mai rar decât în mod normal.

În cazul în care se detectează o operaţiune neautorizată sau un furt, modul rezervorului 
va fi setat automat la modul implicit, readucând rezervorul la scanarea normală şi 
activând din nou toate alarmele.
Alarma de operaţiune neautorizată şi alarma de furt trebuie să fie activate în 
configurarea alarmelor pentru ca această caracteristică să funcţioneze. În cazul în care 
modul rezervorului este, de asemenea, marcat ca suprimând alarmele de operaţiune 
neautorizată, atunci, din nou, această caracteristică nu va funcţiona, deoarece 
suprimarea alarmelor prevalează asupra acestei caracteristici. 

Efectul asupra operaţiunilor „complete”

Un rezervor aflat în modul de fundal poate fi utilizat într-o operaţiune planificată. Atunci 
când este deschisă o operaţiune pe un rezervor aflat în modul de fundal, modul comută 
automat în modul implicit. Cu toate acestea, închiderea unei operaţiuni pe un rezervor nu 
schimbă automat modul înapoi.

Efectul asupra operaţiunilor „simple”

Atunci când este setată o operaţiune pe un rezervor, modul este schimbat automat în modul 
implicit. Închiderea unei operaţiuni pe un rezervor nu va readuce automat rezervorul în 
modul de fundal.

16.1.3 Ştergerea unui mod al rezervorului
Evidenţiaţi modul rezervorului dorit şi faceţi clic pe Delete.

16.1.4 Setarea unui mod al rezervorului
Modurile rezervorului se aplică din ecranele SCADA. Este necesar să configuraţi un element 
de introducere a datelor privind modul rezervorului. Când elementul este configurat, faceţi 
clic pe elementul de introducere a datelor şi se va deschide o fereastră de selectare care va 
afişa modul actual al rezervorului.

BA00396G_0162

Selectaţi modul rezervorului necesar din lista derulantă. Dacă se selectează un mod de 
suprimare, alarma temporizatorului modului rezervorului este setată la valoarea 
preconfigurată a temporizatorului. Aceasta poate fi modificată în caz de nevoie.
Faceţi clic pe OK pentru a accepta modificările sau pe Cancel pentru a le elimina.
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Modul rezervorului selectat va fi afişat în comanda de introducere a datelor.
Accesul la setările modului rezervorului este controlat de sistemul de securitate al 
utilizatorului.

16.2 Starea rezervorului

BA00396G_0163

Pot exista situaţii în care nu este posibil sau de dorit să se utilizeze un rezervor pentru 
încărcarea sau recepţionarea produsului (de exemplu, rezervorul este în curs de întreţinere). 
În acest caz, poate fi setată o stare a rezervorului pentru a bloca operaţiunile.
Starea implicită a rezervorului nu poate bloca operaţiunile şi nici nu poate fi ştearsă, dar 
poate fi redenumită în funcţie de preferinţele dumneavoastră.

16.2.1 Adăugarea unei stări a rezervorului
Dacă faceţi clic pe butonul Add, se va crea New Status. Configuraţi următoarele atribute:
• Name - Oferă stării un identificator unic. Acest nume va fi utilizat pentru selectarea stării 

rezervorului.
• Description – Descriere opţională pentru starea rezervorului. Aceasta este vizibilă doar în 

cadrul ecranului de configurare.
• Movements Blocked – Când este bifat acest atribut, rezervoarele care au fost setate cu 

această stare vor bloca iniţierea operaţiunilor, însă în pachetul de operaţiuni va fi inclusă 
o opţiune de suprareglare.
Notă: acest lucru se aplică numai pentru operaţiunile complete.

16.2.2 Ştergerea stării unei rezervor
Evidenţiaţi starea dorită a rezervorului şi faceţi clic pe Delete.
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16.2.3 Setarea stării unei rezervor
Stările rezervorului se aplică din ecranele SCADA, cum ar fi Single Tank Overview. Este 
necesar să configuraţi un element de introducere a datelor privind starea rezervorului. Când 
elementul este configurat, faceţi clic pe elementul de introducere a datelor şi se va deschide 
o fereastră de selectare care va afişa starea actuală a rezervorului.

BA00396G_0164

Selectaţi starea necesară din listă şi faceţi clic pe OK.
Starea rezervorului selectată va fi afişată în comanda de introducere a datelor.
Accesul la setările privind starea rezervorului este controlat de sistemul de securitate al 
utilizatorului.

16.3 Starea produsului
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Pot exista situaţii în care nu este posibil sau de dorit să se utilizeze un produs dintr-un 
rezervor (de exemplu, produsul este contaminat). În acest caz, poate fi setată o stare a 
produsului pentru a bloca operaţiunile.
Starea implicită a produsului este fixă: această stare nu poate fi ştearsă sau modificată, dar 
poate fi redenumită în funcţie de preferinţele dumneavoastră; de asemenea, starea nu poate 
nici să blocheze operaţiunile.

16.3.1 Adăugarea unei stări a produsului
Dacă faceţi clic pe butonul Add, se va crea New Status. Configuraţi următoarele atribute:
• Name - Oferă stării un identificator unic. Acest nume va fi utilizat pentru selectarea stării 

produsului.
• Description – Descriere opţională pentru starea produsului. Aceasta este vizibilă doar în 

cadrul ecranului de configurare.
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• Movements Blocked – Când este bifat acest atribut, produsele care au fost setate cu 
această stare vor bloca iniţierea operaţiunilor, însă în pachetul de operaţiuni va fi inclusă 
o opţiune de suprareglare.
Notă: acest lucru se aplică numai pentru operaţiunile complete.

16.3.2 Ştergerea unei stări a produsului
Evidenţiaţi starea dorită a produsului şi faceţi clic pe Delete.

16.3.3 Setarea unei stări a produsului
Stările produsului se aplică din ecranele SCADA, cum ar fi Single Tank Overview. Este 
necesar să configuraţi un element de introducere a datelor privind starea produsului. Când 
elementul este configurat, faceţi clic pe elementul de introducere a datelor şi se va deschide 
o fereastră de selectare care va afişa starea actuală a produsului.
Selectaţi starea necesară din listă şi faceţi clic pe OK.
Modul produsului selectat va fi afişat în comanda de introducere a datelor.
Accesul la setările modului produsului este controlat de sistemul de securitate al 
utilizatorului.

16.4 Pompă rezervor

BA00396G_0166

Acest ecran este utilizat pentru a arăta ce pompă este conectată în prezent la un rezervor. Nu 
există niciun control fizic asupra pompelor din acest ecran, acesta fiind doar de referinţă.

16.4.1 Adăugarea unei pompe
Făcând clic pe butonul Add, se va crea o pompă nouă şi se vor configura următoarele 
atribute:
• Name - Oferă pompei un identificator unic. Acest nume va fi utilizat pentru atribuirea unei 

pompe la un rezervor.
• Description – Descriere opţională pentru pompă.
• Tank ID – Selectaţi rezervorul la care este asociată pompa; acest câmp trebuie lăsat gol 

dacă pompa nu este asociată în prezent la un rezervor. 

O pompă poate fi asociată doar la un singur rezervor la un moment dat, însă mai multe 
pompe pot fi asociate la acelaşi rezervor.
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16.4.2 Ştergerea unei pompe
Evidenţiaţi pompa necesară şi faceţi clic pe Delete.

16.4.3 Alocarea pompelor la rezervoare
Pompele sunt alocate rezervoarelor cu ajutorul ecranelor SCADA Single Tank. Este necesar 
să se configureze un element de intrare a datelor privind pompele (este acceptat un singur 
astfel de element pe orice ecran SCADA). După configurare, deschideţi Single Tank Overview 
pentru rezervorul la care doriţi să adăugaţi o pompă şi faceţi clic pe elementul Pumps data 
entry. Se va deschide o fereastră de selecţie care va afişa toate pompele şi alocarea lor 
curentă.

BA00396G_0198

Evidenţiaţi pompa (pompele) pe care doriţi să o (le) alocaţi rezervorului curent şi faceţi clic 
pe OK. Dacă există pompe deja alocate unui rezervor, acestea vor fi eliminate din acel 
rezervor, deoarece pompele pot fi alocate numai unui singur rezervor la un moment dat.
Pompa selectată va fi afişată în comanda de introducere a datelor. În cazul în care sunt 
alocate mai multe pompe unui rezervor, este afişată doar prima pompă, urmată de un semn 
plus (+) pentru a indica faptul că există şi alte pompe alocate rezervorului; treceţi cu mouse-
ul peste comanda de introducere a datelor pentru a afişa o listă completă a rezervoarelor.
Accesul la setările pompei este controlat de sistemul de securitate al utilizatorului.

16.4.4 Eliminarea alocării pompelor
Deschideţi Single Tank Overview pentru rezervorul la care doriţi să eliminaţi o pompă şi 
faceţi clic pe elementul de introducere a datelor Pumps. Se va deschide o fereastră de selecţie 
care va afişa toate pompele şi alocarea lor curentă.

BA00396G_0198

Vor fi evidenţiate pompele alocate rezervorului la momentul respectiv. Pentru a elimina o 
pompă din rezervor, apăsaţi tasta Ctrl şi faceţi clic pe pompă pentru a elimina evidenţierea.
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